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Welcome to Microsoft Word 2010 In Depth! This book is designed to 

be your one-stop reference for Microsoft Word 2010, from the basics of 

Ribbon usage to the intricacies of forms, fields, and customization tools. 

Whether you’re just getting started, are upgrading, or are already a 

Word whiz, this book can help you move up to the next level in exper-

tise.

     How This Book Is Organized  
Microsoft Word 2010 In Depth is organized into these parts. 

  Part I: Working with Text  
This part explains how to create a basic document by typing and editing 

text, saving in various formats, correcting your mistakes, and printing 

your work. These basic skills will pave the way to more extensive edit-

ing later in the book. 

  Part II: Formatting a Document  
In this part, you’ll learn how to format documents on several levels: 

character, paragraph, and document-wide. You’ll discover how to auto-

mate formatting with styles and themes; how to set up sections that 

enable different margin, column, and header/footer information in differ-

ent parts of a document; and how to use and create project templates 

that streamline the process of formatting documents that you frequently 

re-create. You’ll also learn how to create some nonstandard documents, 

such as banners, envelopes, and greeting cards. 

  Part III: Tables and Graphics  
This part explains how to create and format data in tabular format and 

how to insert and format a variety of special-purpose graphical elements 
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including clip art, drawings, charts, SmartArt, and mathematical equations. Most of these graphics 

types have formatting controls in common, so after you’ve learned how to format one type of object, 

the other types become much easier. 

  Part IV: Collecting and Managing Data  
In this part, you’ll learn how to use Word to collect data and to use data to automate tasks. You’ll 

see how to mail-merge labels, letters, envelopes, and catalogs and how to use fields and data entry 

forms to display and collect information. 

  Part V: Working with Long Documents  
This part covers the many tools Word provides for managing lengthy manuscripts, such as research 

papers and books. You’ll learn how to outline and summarize documents, how to create master 

documents that combine several files into a single unit, and how to generate tables of contents and 

other listings. This part also includes information about the new citation management features in 

Word 2010 and explains how to create effective indexes. 

  Part VI: Collaboration and Online Sharing  
In this part, you’ll learn about the tools that Word 2010 provides for sharing your work with others, 

both while it is in the development stages and when it is finalized. You’ll find out how to collabo-

rate on documents with a team, how to protect and secure your files, and how to use Office Live 

and SharePoint Team Services. This part also covers developing online content via Word and gener-

ating XML content. 

  Part VII: Customizing and Extending Word  
This part explains how you can make Word easier to use by adding features such as macros and 

add-ins and by customizing the Word interface. 

  Part VIII: Appendixes  
The appendixes for this book provide an assortment of reference guides, including help for recover-

ing and repairing problems, converting from other word processing systems, and setting up and 

modifying Office 2010. 

  Conventions Used in This Book  
Here’s a quick look at a few structural features designed to 

help you get the most out of this book. To begin with, you’ll 

find Tips, Notes, and Cautions. 

tip
 Tips are designed to point out 
especially quick ways to get the job 
done, good ideas, or techniques you 
might not discover on your own.    
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Often, when a subject is covered in greater detail, you’ll find 

a marker like this, which points you to the location where the 

topic can be found: 

➥    For more information about Word’s automated spelling 

and grammar checker, see “Performing an Interactive 

Spelling and Grammar Check,” p. 98.    

Que’s In Depth conventions are designed to be completely pre-

dictable. It’s easy to understand what you’re reading and what 

you’re supposed to do. 

For example, whenever you should press multiple keys 

together, in this book they are written separated by a plus sign, 

like this: Ctrl+B. That means hold down the Ctrl key, press the 

B key, and then release both keys. 

Terms introduced and defined for the first time are formatted in 

italic.

Text that you are supposed to type is formatted in bold type, as in the following example: 

Run Setup using a command such as setup.exe /q1 /b1.

That’s all you need to know to get the most out of this book. Now fire up your copy of Word 2010 

and let’s have a go at it. 

    Troubleshooting Tips        

Troubleshooting boxes provide advice for getting back to normal when things go wrong. 

note
 Notes offer even more insight into 
features or issues that may be of 
special interest, without distracting 
you from the meat-and-potatoes 
answers you’re looking for.  

caution
 As you’d expect, cautions warn you 
about potential pitfalls and prob-
lems and point out fixes for common 
issues.  



   WORKING WITH FIELDS AND 
FORMS  

     Understanding Fields  
Fields are the often-underappreciated placeholders that work behind the 

scenes in a document. They help perform the magic involved with many 

of the most powerful features in Word, such as mail merging, indexing, 

automatic generation of tables of contents, automatic figure numbering, 

cross-referencing, page numbering, and more. 

There are many different types of fields, each with a specific purpose, 

but they break down into three main categories. You can use fields to do 

the following: 

 • Insert text or graphics into the document, such as page numbering, 

dates and times, text from other documents, graphics from external 

files, document properties, or calculated values. 

 • Mark a location for later use, such as with a bookmark, table of con-

tents marker, or indexing code. 

 • Perform an action, such as running a macro or opening a hyperlink in 

a web browser. 

Many people use fields in Word without even realizing it because so 

many of Word’s features automatically insert and modify fields. For 

example, when you insert a date or time and set it to be automatically 

updated, Word inserts a {Date} or  {Time} code. And when you create 

an OLE link to an object, Word inserts a {Link} code. 

16
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Throughout this book, you’ve been learning about fields in an indirect way. Whenever a feature 

has been discussed that used a field, you’ve learned to insert that field via a button or dialog box, 

but you haven’t looked too deeply yet at what’s really going on behind the curtain. Table 16.1 lists 

some of the Word features that employ fields and cross-references them to where those skills are 

covered in the book. 

  Table 16.1   Word Features That Use Fields   

  Field     Purpose     Covered in   

{AutoText} Inserts an AutoText entry “Working with Building Blocks,” p. 89

{Bookmark} Creates a bookmark marker “Working with Bookmarks,” p. 593

{Date} Inserts an automatically 
updated date 

“Inserting a Date or Time Code,” p. 271

{Hyperlink} Inserts a hyperlink “Working with Hyperlinks,” p. 586

{IncludePicture} Inserts a non-OLE linked 
picture from an external file 

“Inserting a Picture with 
{IncludePicture},” p. 612

{IncludeText} Inserts non-OLE linked text 
from an external file 

“Inserting Text with {IncludeText},”
p. 609

{Index} Generates an index “Generating the Index,” p. 749

{Link} Inserts an OLE-linked object “Creating a Link,” p. 605

{NoteRef} Inserts the number for a 
footnote

“Working with Footnotes and Endnotes,” 
p. 708

{Page} Inserts an automatically 
updated page number 

“Adding and Formatting a Page-
Numbering Code,” p. 269

{PageRef} Inserts the number of the 
page containing the speci-
fied bookmark 

“Inserting a Cross-Reference to a 
Bookmark,” p. 598

{Ref} Inserts the text marked by a 
bookmark

“Inserting a Cross-Reference to a 
Bookmark,” p. 598

{Seq} Inserts an automatically 
numbered caption 

“Using Figure Captions,” p. 412

{Symbol} Inserts a symbol from a 
specified font 

“Inserting Symbols and Special 
Characters,” p. 54

{Time} Inserts an automatically 
updated time 

“Inserting a Date or Time Code,” p. 271

{TA} Marks a table of authorities 
entry

“Creating Citations and Tables of 
Authorities,” p. 737

{TC} Marks a table of contents 
entry

“Creating a Table of Contents,” p. 723

{TOA} Inserts a table of authorities “Creating Citations and Tables of 
Authorities,” p. 737
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  Field     Purpose     Covered in   

{TOC} Inserts a table of contents “Creating a Table of Contents,” p. 723

{XE} Inserts a marker for an 
index entry 

“Marking Index Entries,” p. 741

{=} Inserts a formula or cal-
culated field 

“Performing Math Calculations in a 
Table,” p. 369

This chapter delves into the technical nitty-gritty details that govern fields and shows you how 

you can select, insert, modify, and format fields to accomplish a variety of document-creation and 

formatting tasks. Even if you don’t end up working manually with fields very often, this is not 

wasted study! The more you understand about how fields really work, the better you will be able 

to troubleshoot problems that may occur or to tweak an individual field’s options to fit an unusual 

formatting need. 

  Inserting Fields  
You can insert many fields via the regular Word user interface, as listed in Table 16.1. However, 

you can also insert a field using the Insert Field command, a more direct route that provides access 

to more of the field’s optional switches and parameters. 

To insert a field, follow these steps: 

 1. Position the insertion point where you want the field to be inserted. 

 2. On the Insert tab, click Quick Parts and then click Field. The Field dialog box opens. 

 3. (Optional) On the Categories list, select a category to narrow the list of field names. 

 4. On the Field Names list, click the desired field name. Lists and check boxes appear for the avail-

able options for that field. For example, in Figure 16.1, the options for the Date field are shown. 

 5. Select any options as needed, and then click OK. 

  Specifying Field Properties and Options  
As you insert a field (as in the preceding section), the Field dialog box prompts you to select the 

properties and options you want. Field properties are settings from which you must make a selec-

tion (or accept the default). For example, in Figure 16.1, the date format is a property. If you do not 

choose one, Word uses a default property. Field options are optional parameters; to omit them, sim-

ply leave their check boxes blank. 

If you are interested in the codes behind these user-friendly dialog box controls, click the Field 

Codes button to display the Field Codes text box. It shows the code that Word inserts for the prop-

erties and options you have selected so far (see Figure 16.2).

 Table 16.1   Continued 
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 Figure 16.1 
 Insert a field from the Field 
dialog box.        

 Figure 16.2 
 View the codes behind the 
properties and options 
you have selected.        

IV
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  Manually Typing Field Codes  
If you know exactly what you want in terms of field codes, you 

might find it easier and quicker to simply type them into your 

document.

Field codes are bracketed with curly braces, like this: {Date}.

However, you can’t manually type the curly braces, because 

Word won’t recognize the code as a field. Instead, you must 

press Ctrl+F9 to get the ball rolling. 

Ctrl+F9 inserts a blank set of curly braces in a shaded field box. 

From there you can type the desired field name and any switches or other syntax needed. (If you 

don’t know the exact syntax you need, it’s better to go with the dialog box method of field insertion.) 

Here are some tips for getting the syntax right: 

 • Field names are not case-sensitive. 

 • If a property or argument contains spaces, you must enclose it in quotation marks. For example, 

{Username “John Doe”} would be correct.  {Username John} would also work because John 

does not have spaces in it, but {Username John Doe} would be incorrect. 

To delve even further into the field’s coding, click the Options 

button to display the Field Options dialog box. Each available 

switch and option for the field is listed and described on the 

Field Specific Switches tab. To add one of them, select it and 

click Add to Field (see Figure 16.3).

 

note
 The Field Options dialog box doesn’t 
do anything that the check boxes and 
lists in the Field dialog box don’t do, 
but the description of each option 
in the Description area of the Field 
Options dialog box can help you fig-
ure out what a particular option does.  

 Figure 16.3 
 Work directly with the field’s optional switches and properties 
in the Field Options dialog box.        

tip
 You can add a button to the Quick 
Access toolbar that starts a new 
blank set of field braces. Choose 
File, Options, and click Quick Access 
Toolbar. Select All Commands from 
the Choose Commands From list. Then 
select Insert Field Chars and click Add.  
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 • If you need a real quotation mark, use “\”. 

 • If you’re specifying a path, use double backslashes rather than single—for example, {IncludeText 

C:\\Docs\\Myfile.doc}. This is necessary because single backslashes indicate switches and 

special codes. 

 • Leave one space between the field name and each property or switch. 

 • Leave one space between the backslash (\) in the switch and its parameters. 

 • Leave one blank space to the right of the left bracket and to the left of the right bracket. 

  Common Syntax Errors in Field Codes        

When manually typing the code for a field, it is easy to make a mistake. Word fields have differ-

ent syntax than you might be used to in Excel functions or VBA, for example. 

Here are some of the most commonly broken syntax rules. If you’re having a problem with a 

field code, check to make sure you are following all these rules: 

 • Spaces are required between the outer braces and the codes inside them: 

  • Right: { Date }

    • Wrong: {Date}

 • Spaces are required between each argument and switch in the code, and between the 

switch and its parameter: 

   • Right: { Date \@ “hh:mm” }

   • Wrong: { Date\@“hh:mm” }

 • Text strings must be in quotation marks if they contain spaces: 

    • Right: { Set CompanyName “ACME Corporation” }

    • Wrong: { Set CompanyName ACME Corporation }

 • Do not use colons, semicolons, commas, or any other characters to separate arguments or 

parameters. (This is not an Excel function!) 

    •  Right: { If { Date \n “MM/dd” } = 12/25 “Merry Christmas!” “Have a 

nice day!” }

    • Wrong { If { Date \n “MM/dd” } = 12/25; “Merry Christmas!”; “Have a 

nice day!” }

 • When nesting fields, do not manually type the curly braces for the inner field; insert them 

with Ctrl+F9. 

IV
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  Toggling Between Data and Field Code Views  
By default, a field displays its result in the document rather 

than its code. (Exception: Fields that do not generate results, 

such as bookmarks and index markers, do not display at all by 

default.)

To toggle between displaying the field result and the field code, 

do either of the following: 

 • Select the field and press Shift+F9. 

 • Right-click the field and choose Toggle Field Codes. 

Note that this toggles only the selected field. To toggle more 

than one field at once, select a contiguous area of the document 

that includes multiple fields and press Shift+F9. To toggle all 

the field codes in the entire document at once, press Alt+F9, or 

select the entire document (Ctrl+A) before pressing Shift+F9. 

Field codes in the document appear just like they do in the Field dialog box (refer to Figure 16.2).

They appear with a gray background, which helps you remember they are fields, but that gray 

background does not print and does not appear in Print Preview or Full Screen Reading view. 

  Editing Field Code Strings  
When a field code string is displayed in the document 

(Shift+F9), you can edit it manually just like any other text. The 

trick is knowing what to type. Many fields have fairly complex 

code strings with various properties and options. 

Most people aren’t able to remember all the syntax rules for 

each field type, of course, so Word provides an easier way to 

edit a field code string: Right-click the field code and choose 

Edit Field. The Field dialog box reappears, as in Figure 16.1,

and you can make any changes needed via a friendly dialog box 

interface.

  Nesting Fields  
When you’re using fields that require input, such as the logical condition ones like {Compare} and 

{If}, you might want that input to come from other fields. To manage this, you can nest one field 

inside another. 

For example, you might want to test whether today is a certain day of the week. If it is Friday, this 

message should appear: “Time cards are due today by 5:00 p.m.” Otherwise, this message should 

appear: “Time cards are due on Fridays by 5:00 p.m.” Here’s the complete syntax for that: 

  { If { Date \@ “dddd” } = “Friday” “Time cards are due today by 5:00 p.m.” “Time
  cards are due on Fridays by 5:00 p.m.” }   

note
 There is one minor difference 
between what appears in the Field 
dialog box and what appears with 
codes displayed inline in the docu-
ment. If the Preserve Formatting 
During Updates check box was 
marked in the Field dialog box, the 
 \* MERGEFORMAT  switch appears 
inline. It does not appear in the Field 
dialog box’s version of the code 
string.  

tip
 After creating a custom field code 
string, save it to the Quick Parts 
gallery for easy reuse. To do so, on 
the Insert tab click Quick Parts, and 
then click Save Selection to Quick 
Part Gallery. Store it in any gallery 
you like. (You might want to create a 
new category called Custom Fields, 
for example.)  



Working with Fields and Forms622
PA

R
T

The main thing to remember when nesting fields is that you can’t type the braces for the nested 

fields; you must insert the braces with Ctrl+F9. Let’s go over the general process. 

First, you would start the outer field: 

 1. Press Ctrl+F9 to insert a new blank set of braces. 

 2. Type the desired field name and then any portion of the field’s properties or switches that 

should come before the nested field. 

 3. Press Ctrl+F9 to insert another new blank set of braces, and in the new set, type the field to be 

nested.

 4. Click to move the insertion point to the right of the closing 

bracket for the nested field, and continue typing the outer 

field.

 5. Press F9 to update the field and display its result. 

Here’s another example. The {Set} field creates a bookmark. 

It requires two pieces of information: the bookmark name and 

the text that should be placed within it. So, for example, if you 

want to create a bookmark called CompanyName and set its 

value to Microsoft, the field should read as follows: 

  { Set CompanyName “Microsoft” }   

That’s fine, but what if the company name changes? You can 

instead use the {FillIn} field to ask the user to specify the 

company name: 

  { Set CompanyName { FillIn “Enter the company name” } }   

Now suppose you want to enter that company’s name in the Title field of the document’s proper-

ties. Create another nested set of fields like this: 

  { Title { Ref CompanyName } }     

  Selecting the Right Field  
A big part of using fields successfully in Word is knowing which fields are available and which are 

most applicable to a particular situation. The following sections explain the types of fields available. 

  Date and Time Fields  
In Chapter 7, “Formatting Documents and Sections,” you learned that you can click Date & Time 

on the Insert tab to insert a date or time code via a dialog box interface. If you mark the Update 

tip
 When you’re inserting a date or time 
via the Field dialog box, the exam-
ples that appear in the Date Formats 
list show today’s date. If you are 
more comfortable choosing based 
on the generic syntax, such as M/d/
yyyy, click the Field Codes button 
and then click the Options button; 
the list of formats that appears in 
the Field Options dialog box shows 
the generic codes.  

IV
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Automatically check box in this dialog box, Word inserts a {Date} field rather than the actual date 

or time. If you toggle the field code on an inserted date (Shift+F9), it might look something like this: 

  { Date \@ “M/d/yyyy” }   

The main switch for the {Date} field is  \@, which is followed by the syntax for the date or time for-

mat you want. 

The {Date} field has a few other switches, but you’ll probably never use them: 

 • \h is for the Hijri/Lunar calendar. 

 • \l is used to insert the date with the last format chosen using the Date and Time dialog box. 

 • \s is used for the Saka Era calendar. 

You might be surprised to find that inserting a time with the Date and Time dialog box does not

insert a {Time} field. Instead, it inserts a  {Date} field with time-based formatting. For example: 

  { Date \@ “HH:mm” }   

So what’s the {Time} field for? It’s basically the same as  {Date}, except with fewer options. You 

can’t specify a certain alternative calendar via switches, for example. Strictly speaking, the {Time}

field is redundant. It doesn’t need to exist, except that people expect it to and might not think to 

use a {Date} field to express a time. 

➥    To learn how to create custom date and time formats, see “Constructing a Custom Date or Time 

Format,” p. 636.     

Besides the {Date} and  {Time} fields, there are several other date/time-related fields from which 

you can choose. All of them pull their information from the file’s properties, not from the PC’s clock/

calendar.

 • {CreateDate} displays the file creation date. It never changes, because the document’s cre-

ation date never changes. 

 • {PrintDate} displays the date on which the document was last printed. It updates itself auto-

matically when you print the document. 

 • {SaveDate} displays the date on which the document was last saved. It updates itself auto-

matically when you save the document. 

 • {EditTime} displays the total amount of time spent editing the document. It does not update 

automatically.

  Document Information Fields  
As you learned in “Inserting a Document Property” in Chapter 7, each document has a set of prop-

erties. Some of those properties are editable, such as Author; others are automatically calculated 
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by Word, such as FileSize. You can insert these document properties into the document using the 

document information fields. 

Most of these fields have an obvious one-to-one correlation with a certain property. For example, 

the {Author} field inserts the author’s name, the  {Comments} field inserts any comments that 

have been placed in the document properties, and so on. The field properties vary depending on 

the nature of the information being inserted. Fields that insert text have properties for setting 

text case; fields that insert numbers have properties for choosing a number format. Some fields 

also have additional options. For example, in Figure 16.4, the {FileSize} field’s result can be 

expressed in either kilobytes or megabytes. 

If you do an item-by-item check of fields versus properties, you will find that not every document 

property has a corresponding field. The {DocProperty} field helps overcome this problem. It is a 

generic inserter for whatever document property you specify. Its list of available properties includes 

every property available for the document (except custom properties). 

For example, suppose you want to insert the company name from the Company property. There is 

no Company field, so you would use {DocProperty} like so: 

  { DocProperty Company }   

 Figure 16.4 
 Document information 
fields insert various docu-
ment properties.        

IV
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  User Information Fields  
These three simple fields pull user information from Word. They are somewhat like the document 

information fields. However, this data is not stored with the document, but with the logged-in user 

on the PC: 

 • {UserAddress} inserts the user’s address, if set up in the program. To set up an address, 

choose File, Options, and click Advanced. In the General section, enter the address into the 

Mailing Address box. 

 • {UserInitials} inserts the user’s initials, if set up in the program. To set up initials, choose 

File, Options, click General, and enter the initials into the Initials box. 

 • {UserName} enters the user’s name, if set up in the program. To set up the name, choose File, 

Options, click General, and enter the name into the User Name box. 

  Numbering Fields  
The numbering fields have one thing in common: They help you automatically number various 

types of items in your document. Each is automatically updated whenever you add more numbering 

fields or rearrange existing fields. For example, if you switch the positions of two figure captions, 

they also switch numbering. 

Most of the numbering fields are inserted via Word’s user inter-

face in various contexts, but a few are available only via the 

Field dialog box. The numbering fields are listed here: 

 • {AutoNum} inserts an automatic number. You can specify 

the formatting you want for it (Arabic, Roman, letters, and so 

on). Use this to number anything you like. Each {AutoNum}

code in the document shows an incremented value. 

 • {AutoNumLgl} inserts an automatic number in legal format, 

with or without a trailing period. 

  Document Information Content Controls        

 There is another way of inserting document properties into the document text—content controls. A 
 content control  is an XML-based tag that pulls information from a data source—in this case, your 
document file’s properties.  

 To insert document information via a content control, on the Insert tab click Quick Parts, Document 
Property; then click the desired piece of information, such as Author.  

 Content controls are not fields; they are a type of link. Content controls automatically update when 
their data changes; for example, if you change the author name of the file, an Author content con-
trol updates immediately in the document; in contrast, an  {Author}  field does not.    

note
 The  {AutoNum} ,  {AutoNumLgl} , 
and  {AutoNumOut}  fields are 
sequenced together, so the same list 
continues regardless of which of the 
three field codes you use. There are 
no switches or properties; the list is 
completely automatic.  
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 • {AutoNumOut} inserts an automatic number in outline format. 

 • {BarCode} inserts a delivery point bar code based on the text found in a bookmark. Generally, 

the bookmark points to a ZIP Code field and changes for each mail merge record with the {Set}

field.

 • {ListNum} inserts numbering for a list. This is somewhat like  {AutoNum}, but rather than 

there being three separate fields for regular numbers, legal numbers, and outlines, there are 

field properties that define which type of list to use. The valid values for this property are 

LegalDefault, NumberDefault, and OutlineDefault. Another difference is that you can set the 

level in the list, and you can set a start-at value, so you can have some control over the list. 

 • {Page} inserts the number of the current page. You most commonly use this in headers and 

footers, but you can use it anywhere in the document. 

 • {RevNum} counts the number of times the document has been saved. Each time it is saved, the 

{RevNum} counter is incremented. 

 • {Section} displays the section number where the field is placed. 

 • {SectionPages} displays the total pages in the section where the field is placed. 

 • {Seq} inserts an automatic sequence number. This is the field used for figure captions and other 

automatically numbered items. A bookmark is created to indicate what type of item is being 

sequenced. For example, to automatically number figures, each figure has a caption like this: 

Figure {Seq Figure}. Optional switches can be added for formatting—for example, {Seq 

Figure \? ARABIC}.

  Equation and Formula Fields  
These math-related fields are mostly covered elsewhere in Word; you will seldom have reason to 

insert them manually via the Field dialog box. Here’s a quick round-up of them: 

 • {=} is a formula field. Do not try to construct its syntax manually; instead, click the Formula but-

ton in the Field dialog box and construct the formula via the Formula dialog box. 

 • {Advance} offsets the position of the subsequent text by 

a specified number of points in a specified direction. You 

might use this to fine-tune the positioning of text on a 

page when trying to make printed text line up correctly on 

a preprinted form, for example. 

 • {Eq} inserts an equation using the legacy-style Equation 

Editor (that is, the version from Word 97–2003). Word does 

not recommend that you construct the syntax manually; 

click the Equation Editor button in the Field dialog box to 

open the legacy Equation Editor. 

caution
 For the  {Advance}  field, the 
expected entries for the field options 
are not obvious in the Field dialog 
box. For more information, click Field 
Codes, and then click Options to see 
a complete list of the switches and 
get information about each one.  

IV
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 • {Symbol} inserts a symbol, by character number, from a specified font. If no font is specified, 

the font assigned to the paragraph where the field resides takes precedence. Usually it is prefer-

able to use the Symbol insertion controls on the Insert tab to insert a symbol because you can 

browse for the desired symbol more easily (that is, you don’t have to know its number). 

  Index and Table Fields  
These fields mark entries for tables of contents, indexes, and tables of authorities; then they gener-

ate those items. (The “Table” in this category’s name refers to tables of contents, tables of authori-

ties, and tables of figures, not to ordinary Word tables.) 

These codes are hardly ever inserted manually. A user would use the Table of Contents, Table of 

Authorities, or Index feature in Word to insert the markers and generate the listings. However, it 

is useful to know what the various codes mean, in case you see them in documents and need to 

decide whether to keep or delete them. 

These are the codes for indexes: 

 • {XE} marks index entries. Various properties and options are available for defining an entry, but 

these are best created with the Mark Index Entry dialog box (covered in Chapter 19, “Creating 

Tables of Contents and Indexes”). 

 • {Index} generates the index. 

For tables of contents, these codes apply: 

 • {TC} marks table of contents entries. Usually tables of contents are generated automatically 

based on heading levels, but you can use this field to manually mark some text to be included. 

 • {TOC} generates the table of contents. 

For tables of authorities: 

 • {TA} marks the table of authorities entries. 

 • {TOA} generates the table of authorities. 

➥    To create an index, see “Marking Index Entries,” p. 741 and “Generating the Index,” p. 749.     

➥    To create a table of contents, see “Creating a Table of Contents,” p. 723.     

➥    To create a table of authorities, see “Creating Citations and Tables of Authorities,” p. 737.      

  Link and Reference Fields  
This category contains fields that insert linked content from other locations, as well as fields that 

automatically number pages and footnotes. (Automatic numbering of other items, such as list num-

bering or figure caption numbering, is handled by fields in the Numbering category, covered previ-

ously in this chapter.) 
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Several of the linking-type fields were covered in Chapter 15, “Copying, Linking, and Embedding 

Data.” Here’s a quick review of those: 

 • {Hyperlink} inserts a hyperlink. Hyperlinks are more commonly inserted via the Hyperlink 

command on the Insert tab. 

 • {Link} inserts an OLE link to an object. OLE links are more commonly inserted via Paste Special 

or the Insert Object command. 

 • {IncludePicture} inserts a non-OLE link to an external picture. Picture links are more com-

monly inserted via the Insert Picture dialog box by selecting Insert and Link from the Insert but-

ton’s drop-down list. 

 • {IncludeText} inserts a non-OLE link to an external text file. Text links are more commonly 

inserted via the Insert Text from File command by selecting Insert as Link from the Insert but-

ton’s drop-down list. 

The following fields insert numbering codes: 

 • {NoteRef} inserts the number of a footnote or endnote. These numbers are automatically 

updated as content changes in the document. These are normally placed via footnote and end-

note insertion. 

 • {PageRef} inserts the page number on which the specified bookmark appears. This code is 

inserted when you create a cross-reference that refers to a page number. 

And these fields insert text strings of various types: 

 • {Quote} inserts a literal text string that you specify. For example,  {Quote “Hello world”}

displays the text Hello world. 

 • {Ref} inserts text marked by a bookmark. You learned about this one in  Chapter 15, in the sec-

tion “Inserting a Cross-Reference to a Bookmark.” 

 • {StyleRef} inserts the text from a paragraph that has the specified style applied. For example, 

if you have the title of your document set up with a style called DocTitle, the field {StyleRef 

DocTitle} inserts that title later in the document. 

There are also two AutoText-related fields: 

 • {AutoText} inserts the specified AutoText entry as an updatable link. This is different from 

inserting AutoText items from the Building Blocks feature, as in “Working with Building Blocks” 

in Chapter 2, because the latter inserts an unlinked, nonupdatable copy. 

 • {AutoTextList} creates a shortcut menu based on AutoText entries in the active template. 

You specify some placeholder text to appear in the field. When the user right-clicks the field, a 

pop-up list appears of AutoText entries to choose from to fill in that field. 

IV
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  Document Automation Fields  
The document automation fields are used to set up code strings that automate processes in the 

document. Some programmers prefer to use document automation fields rather than Visual Basic 

for Applications for some basic automation tasks like filling in a form with user information or deter-

mining whether one value equals another. Here are a few simple examples. 

The {Compare} field compares two values and returns a 1 if the comparison is true or 0 if it is false. 

It is a programming construct, useful for setting up logical conditions. For example, you might count 

the number of words in the document with the {NumWords} field and then compare that value to 

1000:

  { Compare {NumWords} >= 1000 }   

This {Compare} field returns a 1 if the word count is 1000 or above; otherwise, it returns a 0. 

The 1 and 0 are all well and good, but it might be nicer to show some meaningful text based on the 

condition. For that, we need an {If} field. Here’s an  {If} field’s syntax: 

   Expression1 Operator Expression2 TextTrue TextFalse    

  Creating a Pop-Up List        

 The  {AutoTextList}  field generates a pop-up list based on the style applied to the field and 
the items in the AutoText gallery that share that same style. Here’s a quick exercise to see how it 
works:   

  1.   Create a new paragraph style called Popup (or anything else you want to call it).   

  2.    Type the text for the first entry you want on your pop-up list into the document and then apply 
the Popup style to it.   

  3.    Select the entire entry, and on the Insert tab, click Quick Parts and click Save Selection to 
Quick Part Gallery.   

  4.   In the Create New Building Block dialog box, set the Gallery to AutoText and save it there.   

  5.   Repeat steps 2–4 for each item you want to appear on the pop-up menu.   

  6.    Position the insertion point where you want the field and then press Ctrl+F9 to start a new, 
blank field. Within the field’s curly braces, type the following:  AutoTextList “Right-click 
here” \s Popup    

  7.   Press Shift+F9 to toggle the field codes off.   

  8.   Right-click the field, and a menu appears showing your AutoText choices.   

  9.   Click one of the choices on the menu to fill in the field.      
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Suppose, for example, that if {NumWords} is at least 1000, we want to print “OK” in the document; 

otherwise, we want to print “Need More Words”. Here’s the {If} field to accomplish that: 

  { IF {NumWords} >= 1000 “OK” “Need More Words” }   

Here are the other available document automation fields: 

 • {DocVariable} inserts the value of a VBA Word document variable. (This is not the same as 

the document’s properties, which you can insert with document information fields covered previ-

ously in this chapter.) 

 • {GoToButton} inserts a button that, when clicked, jumps the insertion point to a specified 

bookmarked location. 

 • {MacroButton} inserts a button that, when clicked, runs a specified macro. 

 • {Print} sends a print instruction to the printer; you can use it to automatically print a docu-

ment, for example. It is usually combined with some other field, such as {If}, rather than stand-

ing alone. 

  Mail Merge Fields  
Chapter 14, “Performing Mail and Data Merges,” covers the Mail Merge feature in Word, which is 

a robust tool for merging the data from one file or database with a document in another file. Most 

of the fields involved in mail merging are automatically inserted when you work through the mail 

merge, or you can insert them using the Rules list on the Mailings tab. 

 • {AddressBlock} inserts data pulled from multiple fields to form a standard postal mailing 

address.

 • {Ask} prompts the user to enter a value to be stored in a bookmark. You can then insert the 

content of that bookmark anywhere in the document via the {Ref} field. 

 • {Compare} compares two values and shows a 1 or 0, depending on whether they match. You 

learned about this field earlier in the chapter in the “Document Automation Fields” section. 

 • {Database} inserts the results of a database query in a Word table. 

 • {Fill-in} prompts the user to enter a value and then displays it in the field. This is different 

from {Ask} in that it does not store the value in a bookmark for later reuse. 

 • {GreetingLine} inserts a greeting line in a mail merge document. You can optionally use the 

\e switch to specify what name to use if the name is blank. For example, you might want some-

thing like Dear Valued Customer.

 • {If} prescribes two different actions to take based on the outcome of a logical test. This is like 

{Compare} except you can specify the output in each situation rather than accepting the default 

1 and 0 outputs. 

IV
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 • {MergeField} inserts a mail merge field. It requires a field name property, like this: 

{MergeField FirstName}.

 • {MergeRec} numbers each merged record in a mail merge. If a filter excludes any records, they 

are still numbered, and the numbered records have gaps in the numbering. 

 • {MergeSeq} also numbers each merged record in a mail merge, but it does not number records 

excluded by a filter. 

 • {Next} goes to the next record. 

 • {NextIf} goes to the next record in a mail merge only if a condition is met. 

 • {Set} assigns new text to a bookmark. 

 • {SkipIf} skips the next record in a mail merge only if a condition is met. It is the opposite of 

{NextIf}.

  Updating and Editing Fields  
Now that you know about the fields you can insert, let’s look at how you can edit the properties of 

a field and update its values after insertion. 

  Updating a Field  
Most fields are not automatically updated each time you open or save the document. (In this way, 

they differ from OLE linked objects, which are automatically updated by default.) 

To update a single field, select it (or click anywhere in it) and press F9, or right-click the field and 

choose Update Field. If you have toggled the display of the field code string on, updating the field 

toggles it back to displaying the results. 

To update multiple fields at once, select them as part of a contiguous selection range and press F9. 

To update all the fields in the entire document, select the entire document (Ctrl+A) and press F9. If 

the update takes too long, you can abort it by pressing Esc. 

You can’t update all fields. Certain fields are not affected by performing an update because they 

do not pull information from a source that can be changed. For example, the Print, MacroButton, 

GoToButton, and Eq fields are like that. 

In addition, certain fields are not affected by performing a manual update because they automati-

cally update themselves. Examples include Date, Time, Page, and Seq. Date and Time update each 

time you open or print the document (or open it in Print Preview), and item-numbering fields such 

as Page and Seq update whenever there is a change in pagination or item sequencing, respectively. 

Before we get into specifics, it’s worth noting that a lot of keyboard shortcuts are involved in work-

ing with fields, and some of them are the only way to accomplish a particular action. Table 16.2

includes a quick summary of these shortcuts. 
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  Table 16.2   Summary of Keyboard Shortcuts for Fields   

  Description     Shortcut   

Save changes to the source file (only for {IncludeText}) Ctrl+Shift+F7

Update the selected field(s) F9

Toggle field code display Shift+F9

Insert a blank set of field braces Ctrl+F9

Run macro (only for {MacroButton}) Alt+Shift+F9

Unlink a field Ctrl+Shift+F9

Go to the next field F11

Go to the previous field Shift+F11

Lock a field from changes Ctrl+F11

Unlock a locked field Ctrl+Shift+F11

  Field Doesn’t Update        

Remember, most fields do not update automatically. To manually update a field, right-click it 

and choose Update Field, or select it and press F9. 

If neither of these methods works, check to make sure the field is not locked. Try unlocking it 

by selecting the field and pressing Ctrl+Shift+F11. Also examine the field’s code and make sure 

that the \! switch is not present. (That switch locks the field against changes.) 

Check to make sure that it’s actually a field. When you right-click it, does the Update Field 

command appear on the shortcut menu? If not, perhaps it’s not a field; it might have gotten 

unlinked (perhaps you accidentally pressed Ctrl+Shift+F9 on it to unlink it), or it might not have 

been a correctly constructed field in the first place. 

If all else fails, delete the field and re-create it. 

  Locking Fields Against Updates  
Some fields can be locked, so they are never updated even when someone issues an Update Field 

command on them. For example, if you use a field to enter the current date on the day the document 

was created, you would not want that field to update every time you open the document. 

Some fields have a Prevent Fields from Being Updated check box in the Field dialog box. Marking 

this check box adds a \! switch in the code string for that field. You can type the switch into the 

code string manually if you find that easier than going back to the Field dialog box. 

If the field you want to lock does not have that \! switch as part of its syntax, here’s another way: 

Click in the field and press Ctrl+F11. To confirm that the field has been locked, right-click it; the 

Update Field command is unavailable on the menu that appears. 

To unlock a field that has been locked this way, click in it and press Ctrl+Shift+F11. 

IV
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  Updating Fields for Printing  
By default, Word does not automatically update fields before 

printing. This is intentional, because it gives you more control 

over your data. If you would like to change this behavior so that 

all links are updated before printing, open the Word Options 

dialog box (File, Options), click Display, and mark the Update 

Fields Before Printing check box. 

     Finding and Moving Between Fields  
Sometimes it can be difficult to know where the fields are actually located in a document, especially 

when some of the fields do not contain visible content, such as a bookmark or index marker. 

There are several ways to surmount this obstacle. One way is to select the entire document and 

toggle the field codes (Shift+F9). It doesn’t take you to the codes, but it makes them easy to see. 

Another way, which you can actually combine with the preceding one, is to go to the next field 

code by pressing F11 or to the previous one by pressing Shift+F11. Word jumps to the beginning of 

the next or previous field. You might not see anything there (if the field is hidden), but after jump-

ing to that spot, right-click the spot and choose Toggle Field Codes or press Shift+F9, and the field 

appears.

A third way is to use the Select Browse Object feature, covered in Chapter 2, “Typing and 

Editing Text,” to move from one field to the next. Click the Select Browse Object button (or press 

Ctrl+Alt+Home) and choose Browse by Field to go to the next field. 

➥    To review Select Browse Object as a method of finding objects, see “Using Select Browse 

Object,” p. 80.      

  Converting Fields to Plaintext  
If you decide at some point that you will never want to update a 

particular field again, you can convert it to regular text (that is, 

unlink it). Doing so copies its current value into the document 

and then deletes the field placeholder. 

Before unlinking a field, update it one last time (F9) if needed. 

Then select it (or select multiple fields to operate on at once) 

and press Ctrl+Shift+F9. You can reverse an unlink with an 

Undo operation, but otherwise it’s a one-way route. To restore the field, you need to reinsert it from 

scratch.

  Formatting Fields  
When a field inserts data from another source, such as from a bookmark or an external text file, the 

formatting of the original is inserted, too. For example, suppose you bookmark the text The New 

Deal in one section of your document, and you create a bookmark for it called NewDeal. Now when 

tip
 You do not have to turn on Update 
Fields Before Printing for dates 
and times to update; they update 
automatically when you view the 
document in Print Preview or when 
you print.  

note
 Unlinking has no effect on a marker 
type of field, such as a bookmark or 
index entry.  
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you insert that bookmarked text elsewhere in the document with the {Ref NewDeal} field, the 

inserted text appears bold and in italic. 

That’s the basic default for the formatting, but there are some ways to circumvent that, as you’ll 

learn in the next several sections. 

  Preventing the Formatting from Changing  
What happens if you change the formatting of the original and then update the field? That depends 

on a switch. Ordinarily the formatting would change, but you can prevent it from changing by using 

the \* MERGEFORMAT switch. For example: 

  { Ref NewDeal \* MERGEFORMAT }   

You can also employ MERGEFORMAT to lock in any manual formatting you have applied to the field. 

  Specifying Font Formatting for a Field  
To apply specific font formatting to the text displayed in a field, toggle on the field code display and 

then format the first character in the field name the way you want the field result to be. (Font for-

matting in this context includes font, size, color, and attributes such as bold, italic, and underline.) 

For example, with the {Ref} example from the preceding section, suppose you want to format that 

field’s result as italic. Select the “R” in “Ref” and click the Italic button Mini Toolbar that appears. 

Then add \* charformat to the end of the code string. (This part is not required if the field has no 

arguments.)

  {  R ef NewDeal \* charformat }   

Then update the field (F9) to see the change. 

  Specifying a Numbering Type  
Numeric fields can use any of several types of characters to represent the numbers, such as Arabic 

(1, 2, 3), Roman (I, II, III), and so on. To specify the type of numbering, use the \* switch followed 

by the appropriate code. The easiest way to set a numbering type is in the Field dialog box; it 

provides a list of the available types. Alternatively, you can use switches in the field code, as in 

Table 16.3. (Note that the codes are case-sensitive; alphabetic is different from ALPHABETIC, for 

example.)

  Table 16.3   Codes for Numbering Types   

  Numbering     Switch     Example     Notes   

1, 2, 3 \* Arabic 23

a, b, c \* alphabetic w After the 26th letter, the letters start 
repeating: 27 would be aa, 28 would be 
ab, and so on. 

IV
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  Numbering     Switch     Example     Notes   

A, B, C \* ALPHABETIC W Same as preceding except uppercase. 

i, ii, iii \* roman xxiii

I, II, III \* ROMAN XXIII

1st, 2nd, 
3rd

\* Ordinal 23rd

First,
Second,
Third

\* Ordtext twenty-third

One, Two, 
Three

\* Cardtext twenty-three

Hex \* Hex 17 Hexadecimal numbering. Each place is 
16, so 23 would be 1 × 16 plus 7. 

Dollar
Text

\* DollarText Twenty-three
and 00/100 

Converts numerals to written-out words 
for the numbers. This is the format tradi-
tionally used for writing checks. 

  Constructing a Custom Numeric Format  
A numeric field’s number format (aka the numeric picture) controls the appearance of the number 

in cosmetic ways, such as its number of decimal places, its presence of currency symbols or percent 

signs, and so on. 

The easiest way to set the number format is in the Field dialog box; a list of available types is pro-

vided. It is much easier to construct the codes this way than to build them manually. Alternatively, 

you can use the \# switch, followed by the numbering format in quotation marks. For example: 

  { FileSize \# “#,##0” }   

If you want to build the numbering format code manually, consult Table 16.4 for the symbols to use. 

  Table 16.4   Codes for Numeric Pictures   

  Character     Purpose     Notes   

# A number if present; 
otherwise, a blank 
space. Rounds off extra 
fractional digits. 

Use this to limit a number to a maximum number of 
decimal places, like this: #.##. Any places not needed 
do not appear. 

0 A number if present; 
otherwise, a zero. 

Use this to force a number to a minimum number of 
decimal places, like this: 0.00. Any places not needed 
appear as zeros. 

$ Places a literal dollar 
sign in the field result. 

 Table 16.3   Continued 
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  Character     Purpose     Notes   

+ Places a plus or minu s 
sign in front of any field 
result other than zero. 

This is not a literal plus sign; it changes to a minus 
sign for a negative number. 

– Places a minus sign in 
front of negative num-
bers.

This is not a literal minus sign; it does not appear for a 
positive number. 

. Places a literal decimal 
point in the field result. 

Use this to separate # or 0 codes to show where in the 
number those codes are referring to. For example, 0.0# 
indicates a required digit before and after the decimal 
point in the number and an optional second decimal 
place if needed. 

, Places a literal comma 
in the field result. 

Use this to separate hundreds from thousands to the 
left of the decimal point: #,###.##. 

It does not necessarily conform to common usage that 
dictates a comma every third place; you could just as 
easily set up one like #,0 that would place a comma 
between the first and second digits. 

; Separates multiple 
options for a number. 

You can have separate formatting sections for positive, 
negative, and zero numbers, in that order. For example, 
$###.00;($###.00),$0.00.

text Adds literal text to 
the format. 

Enclose in single quotes. For example, use this to 
include the word Dollars after the number: ###.00 
’Dollars’

  Constructing a Custom Date or Time Format  
When you select a date or time from the Date and Time dialog box or from the Field dialog box, a 

list of sample formats appears. Choosing a format from one of those locations relieves you of the 

need to manually construct a date/time picture with switches. 

However, in some cases, the format you want might not be available on the list. In such situations, 

you must manually construct the needed code for the switch. 

For date and time fields, a \@ switch is used, followed by the desired formatting codes in quotation 

marks. For example: 

  { Date \@ “MMMM d yyyy” }
  { Time \@ “hh:mm AM/PM” }   

The code is a combination of placeholders and literal characters. The valid literal characters are 

colon (:), dash (-), and slash (\). They separate the parts of the date or time. Typically, colons sepa-

rate hours, minutes, and seconds in times, and dashes or slashes separate months, days, and years 

in dates. 

The valid characters for placeholders are shown in Table 16.5.

 Table 16.4   Continued 
IV
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  Table 16.5   Codes for Date or Time Formats   

  Characters     Purpose     Sample Code     Sample Result   

M Month number, 1 through 12 { Date \@ “M” } 8

MM Month number, 01 through 12 { Date \@ “MM” } 08

MMM Three-letter month abbrevia-
tion

{ Date \@ “MMM” } Aug

MMMM Full month name { Date \@ “MMMM” } August

d Day number, 1 through 31 { Date \@ “d” } 5

dd Day number, 01 through 31 { Date \@ “dd” } 05

ddd Three-letter day of the week 
abbreviation

{ Date \@ “ddd” } Tue

dddd Full day of the week { Date \@ “dddd” } Tuesday

y Two-digit year { Date \@ “y” } 10

yy Four-digit year { Date \@ “yy” } 2010

h Hour on 12-hour clock, 1 
through 12 

{ Time \@ “h” } 3

hh Hour on 12-hour clock, 01 
through 12 

{ Time \@ “hh” } 03

H Hour on 24-hour clock, 0 to 23 { Time \@ “H” } 3 or 17 

HH Hour on 24-hour clock, 00 to 23 { Time \@ “HH” } 03 or 17 

m Minutes, 0 to 59 { Time \@ “m” } 4

mm Minutes, 00 to 59 { Time \@ “mm” } 04

AM/PM AM or PM, uppercase { Time \@ “hh:mm AM/PM } 03:04 AM 

am/pm am or pm, lowercase { Time \@ “hh:mm am/pm } 03:04 am 

  Understanding Forms  
Forms enable you to collect information from people via a fill-in-the-blanks interface. The forms you 

create in Word can be printed and completed on paper or filled out from within Word. With a little 

extra programming know-how, you can connect them to an XML data system or an Access data-

base.

Word 2007 introduced a whole new class of form fields called content controls, which are used 

throughout Office 2010 applications as a means of interfacing with external data sources. These 

content controls have some great capabilities that were not present in Word 2003 and earlier, but 

they also have a few drawbacks. Therefore, Word 2010 also provides access to—and support for—

legacy form controls that work in backward-compatible documents. In the following sections, you 

learn about both. 
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  Designing a Form  
The first step in creating a form is to create an ordinary Word document that contains all the 

“fixed” text used on the form. For example, before creating a Name field that the user fills in, type 

Name in the document and leave some space after it for the field to come later. To ensure that there 

is enough space for the fields, you might enter dummy characters where they will go, like this: 

Name: &&&&&&&&&&&&&&&&&&&&&&&& 

Address: &&&&&&&&&&&&&&&&&&&&&&& 

City: &&&&&&&&&&&&&& State: && ZIP: &&&&&-&&&& 

If you simply type the text and placeholders into a document, though, the form might not be as tidy 

as you would like. Notice in the preceding example how the Name and Address text, having differ-

ent numbers of characters, start the field at different spots. Adding a Tab character after the colon 

for each label might help with that: 

Name: &&&&&&&&&&&&&&&&&&&&&&&&

Address: &&&&&&&&&&&&&&&&&&&&&&&

City: &&&&&&&&&&&&&& State: && ZIP: &&&&&-&&&& 

There’s still an alignment issue with the State and ZIP, though. They aren’t aligned with anything 

in particular; they’re just hanging out there after City. So what if you put the whole thing into a 

table, like this? 

Name:

Address:

City: State: ZIP:

As you can see, a table can be a great help in creating a form on which the fields and labels align in 

an orderly way. If you define separate cells for each label and entry, you don’t need the placehold-

ers to define where the fields will go. Tables are not appropriate for every form project, but they’re 

a good addition to your toolbox of techniques. 

The form does not necessarily have to be in a single table; you could divide it into several tables, or 

you could use a combination of regular text and tables. Figure 16.5 shows an example. This is pure 

text and table at the moment—it contains no form fields. 

Using whatever layout you find the most expedient for your situation, design the form and lay out 

all its pieces with placeholders, as in the preceding examples. Here are some tips: 

 • Arrange fields in logical groups— Group the information into sections based on the type of 

information being gathered. For example, in Figure 16.5, the contact information is in one group, 

and each question being asked of the applicant is in a separate group. Each group is in its own 

table in this example, but you don’t necessarily have to use tables for yours. 

IV
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 • Place fields in the expected order— People expect certain fields to be in a standard order. For 

example, they expect City to come before State. If you mix them up, users may have problems 

filling out the form. 

 • Plan for different types of fields— When you actually insert the fields, you can use not only text 

boxes, but drop-down lists, option buttons, and check boxes. If you think any of those will be 

useful, insert placeholders for them—and leave enough space for them. For example, a set of 

option buttons takes up more space than a drop-down list. 

 • Leave enough space for user input— Users will be frustrated if their information won’t fit 

on the form. Leave plenty of space for names, addresses, and so on. Maximilian Theophilus 

Kreutzcampf will thank you for it. 

 • Be clear with your labels— Make sure it’s obvious what users should put in each field. For 

example, suppose you have a City of Birth field, followed by a field labeled Date. Do you want 

the date of birth there, or the current date? Fifty percent of your users will probably guess 

wrong.

  Saving a Form as a Template  
The form isn’t finished yet, of course, but now is a good time to save your work as a template. 

You’ll want a template file, not a regular document file, because users will be creating new docu-

ments based on it. 

 Figure 16.5 
 Create the skel-
eton of a form, 
to be populated 
with form fields 
later.        
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To save the form as a template, follow these steps: 

 1. Choose File, Save As. The Save As dialog box opens. 

 2. Open the Save as Type list and choose Word Macro-

Enabled Template (.dotm). If you aren’t planning on storing 

macros in the template, you could go with Word Template 

(.dotx) instead. 

 3. In the File Name box, type the name for the template file 

(see Figure 16.6).

 4. Click Save. The template is saved.  

tip
 If you want the template to be eas-
ily accessible when starting a new 
document, store it in the default 
location for user templates: C:\
Users\ username \AppData\Roaming\
Microsoft\Templates.  

 Figure 16.6 
 Save the document as a tem-
plate. (You’ll resave it after 
inserting the form fields.)        

  Differentiating Between Content Controls and Legacy Fields  
Now you’re ready to start inserting the form fields. There are two kinds, though—the Word 2010 

form fields (aka content controls) and the legacy form fields that are a carryover from Word versions 

2003 and earlier. 

Content controls are a natural choice if all the users of your form are using Word 2007 or 2010. Here 

are some of the advantages: 

 • There are more types of controls, including rich text, pictures, and a calendar/date picker. 

 • The document doesn’t have to be protected for forms, so you won’t have trouble with disabled 

commands such as spell-checking that plague protected forms. 

IV
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 • You can set a content control so that it can’t be deleted or so that it unlinks itself immediately 

after it’s filled in. 

 • Their XML format makes form fields ideal for connecting with XML data sources. 

There are a few things you can’t do with content controls that the legacy form fields  can, however: 

 • You can’t save the data only in a separate Word document. 

 • You can’t easily link a macro to a control. 

 • You can’t automatically format input in a predefined number format (such as currency). 

 • You can’t set up a form field that performs a calculation. 

 • You can’t limit the length of an entry. 

 • You can’t fill out a Word 2010 form Word 2003 or earlier. 

This chapter focuses mostly on content controls, but it also provides information about the legacy 

form fields in case you need their capabilities or their backward compatibility. 

You can combine the two types of fields in a single form. However, beware when combining the 

two field types, because they work differently behind the scenes. Here are some reasons to stick to 

one field type or the other: 

 • Saving data only— If you want to save the data only from 

the form into a plaintext file (covered later in this chapter), 

use legacy fields only. This won’t work with content control 

fields.

 • Supporting Word 97–2003 users— If the form will be filled 

out by people who use earlier versions of Word, use legacy 

fields only, and make sure you save the template as a Word 

97–2003 template (.dot), not a Word 2010 .dotx or .dotm file. 

 • Preparing a database front end— If you are creating the 

form as a user interface for entering data into a database, 

check with the database developer to find out what type 

of fields you should use—content controls or legacy fields. 

Stick only with that type. Don’t mix and match, because that 

makes the programming of the connection difficult or impos-

sible.

On the other hand, if you are creating a form to be printed or to be filled out in Word 2007 or 2010 

only and saved as a new Word 2010 document, you can use both field types freely. 

caution
 If you create a form using content 
controls and then use Save As to 
save the form in a Word 97–2003 
format, a warning appears telling 
you that the fields will be converted 
to static text. That’s right— static 
text , not legacy form fields, as you 
might expect. You lose all your form 
fields with that backward-saving, so 
make sure you construct the form 
using legacy fields if you think you 
will be saving in an older format 
later.  
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  Displaying the Developer Tab  
To work with forms, you need to work with the Developer tab. It does not appear by default. Here’s 

how to display it: 

 1. Choose File, Options. 

 2. Click Customize Ribbon. 

 3. Mark the Developer check box on the list on the right side of the dialog box. 

 4. Click OK. 

The Developer tab appears just to the right of the View tab. On the Developer tab is a Controls 

group that contains the buttons you need to build your form. 

The Controls group contains eight buttons for Word 2010 content controls, plus one button for 

legacy and ActiveX controls. That latter button opens a palette of the legacy controls, as shown in 

Figure 16.7.

The Design Mode button in the Controls group toggles the form between Design Mode (where 

fields can be added and edited) and regular mode (where fields can be used to collect information).   

 Figure 16.7 
 You use the Controls group on the Developer tab to insert form fields.        

  Creating a Form with Content Controls  
Content controls work only in Word 2007 and higher documents and templates. They look nice 

(friendly pale-blue frames with names, as opposed to the plain drab gray boxes in legacy forms), and 

they are easy for users to understand and use. You can apply formatting styles to them, and you can 

prevent them from being edited or deleted. 

  Inserting a Content Control  
To insert a content control, follow these steps: 

 1. Position the insertion point where you want the new control. 

 2. On the Developer tab, make sure Design Mode is selected. 

 3. Click one of the content control buttons on the Controls group to insert it into the document. 

IV
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There are eight content controls you can insert, summarized in Table 16.6. On the Developer tab’s 

Controls group, point to a button to determine which content type it represents. 

  Table 16.6   Content Control Types   

  Control     Purpose   

Rich Text Holds text that the user can optionally format (bold, italic, and so on). 

Plain Text Holds plaintext that the user cannot format. 

Picture Holds a picture that the user inserts. 

Building Block 
Gallery

Inserts a placeholder from which the user can select a building block from a 
gallery you specify. 

Combo Box Displays a list of values from which the user can select, and allows the user to 
enter other values. 

Drop-Down
List

Displays a list of values from which the user can select. Other values are not 
permitted.

Date Picker Displays a calendar from which the user can click a date. 

Check Box Displays an on/off check box toggle. (This type is new in Word 2010.) 

  Configuring a Control  
A content control is generic after insertion; you must provide its context via its Properties box. To 

view the Properties for a control, select it and then click the Properties button in the Controls group 

on the Developer tab. 

  Settings Common to All Control Types  
The options available in the Properties dialog box depend on the control type, but all controls have 

a Title box, in which you specify the text that should appear in the thin blue bar across the top of 

the control. Figure 16.8 shows a photo with a title of January, for example. 

The Locking settings shown in Figure 16.8 are also available for all types of controls: 

 • Content control cannot be deleted— This prevents users from deleting the control. 

 • Contents cannot be edited— This prevents users from changing what they enter in the control 

after the initial entry.  

  Style Options  
By default, a field takes on the paragraph formatting of whatever paragraph you place it in. For 

some field types, though, you can override this formatting by applying a different style to the field 

entry.

For Rich Text, Plain Text, Combo Box, and List Box, you can mark Use a Style to Format Contents 

and then select a style from the Style list (see Figure 16.9). You can also click New Style to create a 

new style on the fly for it.  
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  Multiparagraph Text Options  
For a plaintext field only, you can choose Allow Carriage Returns (Multiple Paragraphs). This option 

enables users to press Enter to start a new paragraph within the field. This option is not available 

for rich-text fields because they always allow this. 

  Field-Removal Options  
For both rich text and plaintext, you can choose Remove Content Control When Contents Are 

Edited. This option deletes the field placeholder after the user enters text into it, leaving only the 

text as a regular part of the document. 

 Figure 16.8 
 These content control options are common to 
all types of controls.        

 Figure 16.9 
 For text fields, you can specify a style to apply.        

IV
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  List Options  
Combo boxes and list boxes enable you to set up the list that appears when the user activates the 

control. In the Drop Down List Properties area of the Content Control Properties dialog box, follow 

these steps: 

 1. Click Add. The Add Choice dialog box opens. 

 2. Enter the Display Name. This is the text that appears on the screen. 

 3. Enter the Value. This is what you enter into the database if you are connected to the form; oth-

erwise, this is just stored with the field (see Figure 16.10). 

 4. Click OK. 

 5. Repeat steps 1–4 to add more choices to the menu. 

 6. (Optional) Modify the list by doing any of the following: 

   • To modify an entry, select it, click Modify, make changes, and click OK. 

   • To delete an entry, select it and click Remove. 

   • To reorder the list, select an item and click Move Up or Move Down. 

 7. Click OK. 

 Figure 16.10 
 Set up a list from which users can select.        
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  Date Options  
For a date field, you can control these four settings, as shown in Figure 16.11:

 • Display the Date Like This— Select a format from the list provided. 

 • Locale—Select a country and language. 

 • Calendar Type— Select a type based on your country. In the United States and most of Europe, 

the calendar is Western. 

 • Store XML Contents in the Following Format When Mapped— This setting is important only if 

you will be connecting to an XML data source. Select from the list of formats provided.  

 Figure 16.11 
 Set date options for a Date content control.        

  Check Box Options  
For a check box, you can control how the box appears when it is checked and when it is unchecked. 

To control the appearance, from the Properties box for the control, click the Change button next to 

Checked Symbol or Unchecked Symbol. Then select a new symbol from the Symbol dialog box that 

appears. You do not have to use square boxes; you can have it appear as any character or symbol 

you like. See Figure 16.12. 

IV
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  Building Block Options  
The same versatile building blocks that you have learned about 

in other chapters are available for use in forms. For example, 

you can access any built-in or custom galleries such as 

Equations, AutoText, and Quick Parts. 

The implications of this capability are significant. For example, 

suppose you have a set of boilerplate paragraphs that you want 

to be able to select among when composing letters. You could 

place a Building Blocks field in your template and then have 

easy access to those paragraphs by clicking that field whenever you are creating a new letter. 

The default building block content control doesn’t do anything at first; you have to set it up to be 

associated with a certain gallery and category. To set that up, choose a gallery and category from 

the Document Building Block Properties. 

➥    To learn more about building blocks, including how to create your own categories, see 

“Working with Building Blocks, p. 89.       

  Editing Placeholder Text  
The placeholder text for a content control is the text that 

appears inside the box by default, with instructions such as 

Click here to enter text. If you like, you can customize the word-

ing of that instruction so that it is different for each field. For 

example, for a control that holds first names, you could change 

it to Click here and type your first name.

 Figure 16.12 
 Select a dif-
ferent symbol 
to represent 
the marked 
and unmarked 
check boxes.        

caution
 Building block insertion works only 
if the PC on which the form is being 
completed has the same building 
blocks available.  

note
 Most of the changes you make 
to content control options do not 
require Design Mode to be on; edit-
ing the placeholder text is one of the 
few situations where you do need it. 
You can leave it on or off as desired 
as you work on a form.  
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To edit a placeholder, follow these steps: 

 1. On the Developer tab, click the Design Mode button to turn on Design Mode if it is not already on. 

 2. Click inside the control, where the placeholder text is, and edit the placeholder text there. 

  Creating a Form with Legacy Form Fields  
Legacy form fields are the field types that were available in earlier versions of Word. You can con-

tinue to use them in Word 2010, and you must use them for forms to be saved in Word 97–2003 

format.

Legacy form fields are accessible from the Legacy Tools button’s menu in the Controls group on the 

Developer tab, as you saw in Figure 16.7. Table 16.7 explains each of them. 

  Table 16.7   Legacy Form Field Types   

  Form Field Type     Purpose   

Text Form Field Holds text. Unlike with content controls, you cannot format the text 
within the field; however, you can format the field. 

Check Box Form Field Creates an on/off check box. 

Drop-Down Form 
Field

Displays a list containing values you specify. Users cannot add 
their own entries. 

Yes, there are only three types of legacy form fields. The other three buttons in the Legacy Forms 

section of the list have other purposes. Table 16.8 describes them. 

  Table 16.8   Legacy Form Tools   

  Tool     Purpose   

Insert Frame Creates a frame. Frames are similar to text boxes; they hold static con-
tent.

Form Field Shading Toggles form field shading on/off. 

Reset Form Fields Clears all entries in fields. 

  Can I Create Forms Within Email Messages?        

Yes, but you can also send Word forms as email attachments in any email program, which actu-

ally might be a better way to go because of the limitations of some of the email clients that the 

recipients might be using. 

When people receive an email with form fields (use legacy fields for this, by the way), they 

see the fields embedded in it. Then when they reply to the email, those fields are editable. See 

Chapter 22, “Developing Online-Delivered Content,” for more information about how Word 

works with email. 

IV
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  Inserting a Legacy Field  
To insert any legacy field, follow these steps: 

 1. Position the insertion point where you want the field. 

 2. On the Developer tab, make sure Design Mode is selected. 

 3. In the Controls group, click the Legacy Tools button. Its palette of tools appears. 

 4. Click the desired field type. 

The field appears in the document as either a shaded gray box (for drop-down lists and text boxes) 

or as a check box (for check boxes). 

Inserting a field is simple, but you will probably want to configure it after insertion. One advantage 

of legacy form fields is that they have some different formatting and configuration options avail-

able than content controls. Depending on what you want to do with the form, the legacy form fields 

might have just the option that will make your life easier. 

To view the properties for a form field, right-click it and choose Properties, or click the Properties 

button on the Developer tab. If there is no Properties command, make sure Design Mode is marked 

in the Controls group and click the Properties button. Figure 16.13 shows the Properties box for a 

text field.  

 Figure 16.13 
 Set properties for a legacy form field.        

  Configuring Legacy Text Field Options  
There are three basic field types: Regular Text, Number, and Date. Depending on which of these 

types you select, different formatting options and length restrictions become available in the 

Options dialog box. The other three choices on the Type menu are special-purpose types, discussed 

later in this chapter. 
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If you choose Regular Text, the options shown in Figure 16.13 are available: 

 • Default Text— You can optionally specify default text to appear in the field before the user 

enters his or her own value. 

 • Maximum Length— This is measured in number of text characters. The default is Unlimited. 

 • Text Format— Choose among Uppercase, Lowercase, First Capital, or Title Case. 

➥    To learn about First Capital and Title Case as formatting options, see “Changing Text Case,” 

p. 166.     

If you select Number, you can choose among these options: 

 • Default Number— This is just like Default Text; enter a default if desired. 

 • Maximum Length— This is measured in number of digits. 

 • Number Format— This drop-down list lets you specify a numeric format, some of which include 

currency symbols or percentage signs. 

➥    For information about number format codes, see “Constructing a Custom Numeric Format,” 

p. 635.  You cannot construct a custom format here, but that section helps you understand the 

available choices.    

Finally, if you choose Date, you can choose among these options: 

 • Default Number— This is just like Default Text; enter a default if desired. 

 • Maximum Length— This is measured in number of digits. It is not typically limited for dates, 

because dates take up only as much space as they need. 

 • Date Format— This drop-down list lets you specify a date format, including various combinations 

of month, day, and year. 

➥    For information about date format codes, see “Constructing a Custom Date or Time Format,” 

p. 636.  You cannot construct a custom format here, but that section will help you understand 

the available choices.    

  Inserting the Current Date or Time  
If you choose Current Date or Current Time from the Type list 

in the field’s Options dialog box, the field changes to show the 

current date or time, as determined by the PC’s clock. The field 

no longer accepts user input. It does not automatically update, 

but you can update it manually by selecting it and pressing F9. 

     Setting Up a Calculation  
If you choose Calculation as the type for the field, an Expression text box appears in the Field 

Options dialog box. In it, enter the formula for the calculation (see Figure 16.14). You can then use 

any of the calculation methods that Word supports. 

➥    For more information about the calculations that you can perform in Word, see “Performing 

Math Calculations in a Table,” p. 369.       

tip
 For best results, set up the data to 
be calculated in a table, and place 
the calculated field in that same 
table. That way, you can refer to var-
ious cells by their row and column 
designators.  

IV
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  Configuring Legacy Check Box Options  
Check boxes are useful when you have a list of items and the user can select as many of them as he 

or she wants. 

Check boxes have two unique options you can set for them, shown in Figure 16.15:

 • Check Box Size— The default is Auto, which makes the check box the same size as the text that 

follows it. If you prefer, you can choose Exactly and enter a size in points. 

 • Default Value— This is set to Not Checked unless you specify otherwise. It determines the check 

box’s starting state. 

 Figure 16.14 
 Set up a Calculation field 
within a table, and refer-
ence cells by row (num-
ber) and column (letter).        

 Figure 16.15 
 Set the options for a check box.        
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  Using Option Buttons on a Form  

 Option buttons are sets of mutually exclusive options, such as Yes/No/Maybe. When the user 
selects one of them, the others in the group become deselected.  

 Technically, Word has no capability for option buttons on form fields. However, Word does offer 
an ActiveX option button. It won’t work seamlessly with your other fields if you have big plans 
for connectivity with a database, and it won’t be included if you save or print the data only in a 
form. However, if you are designing the form to be filled out and saved in ordinary Word docu-
ments or on paper, you are probably more concerned with the look of the form than its back-
end functionality.  

 To create an option button set, follow these steps:   

  1.   Position the insertion point where you want the first option button.   

  2.    On the Developer tab, in the Controls group, click Legacy Tools, and in the ActiveX section, 
click Option Button (the round button, fourth from the left on the top row). A new option 
button and placeholder label appear.   

   3.   Right-click the option button and choose Properties. The Properties pane opens.   

  4.   In the Caption box, type the text that should appear next to the button.   

  5.    In the GroupName box, type any name you like. (It must be the same for all buttons in the 
group, though.)   

  6.    Repeat steps 2–5 to insert more option buttons, and make sure they all have the same 
GroupName.   

  7.   Close the Properties pane.   

  8.   Turn off Design Mode on the Developer tab and try out the buttons.    

 If you are interested in doing some VBA programming behind an ActiveX control so that it actu-
ally does something other than sit there and look good, right-click the control while in Design 
Mode and choose View Code, and then work in the Microsoft Visual Basic window that appears. 
(You have to know how to program in VBA for this to be much help to you.)   

  How Can I Program ActiveX Controls?        

If you want to actually do some programming for an ActiveX field, you must know Visual Basic 

for Applications (VBA). To access the Visual Basic editor for a control, right-click the control 

while in Design Mode and choose View Code. Then work in the Microsoft Visual Basic window 

that opens. 

IV



653Creating a Form with Legacy Form Fields

16

C
H
A
P
TER

  Configuring Legacy List Options  
A legacy list box, also called a Drop-Down Form Field, is like 

the list box content control. It does not allow the user to input 

his or her own entries like a combo box does. 

The main thing to set up for a list box is the list itself. Follow 

these steps to create the list: 

 1. From the Options dialog box for the field, type the first list 

item in the Drop-Down Item text box. 

 2. Click the Add button. 

 3. Repeat steps 1–2 to enter the other values (see Figure 16.16).

 4. (Optional) If you need to remove an item, select it and click Remove. 

 5. (Optional) To reorder an item, select it and click the Move up and down arrows. 

 6. Click OK.  

caution
 If you see a Properties pane instead 
of the dialog box when you attempt 
to open the Options dialog box for 
a legacy text box, check box, or list 
box, make sure you have chosen 
a control from the top row of the 
Legacy Controls list, and not one of 
the ActiveX controls.  

 Figure 16.16 
 Create the drop-down list options.        

  Setting a Macro to Run on Entry or Exit  
If you have macros stored in the template or document, you can 

run one of them when the user enters or exits a particular field. 

For example, you might want to set up a macro that saves the 

file and associates it with exiting the final field on your form. 

To set a macro to run on entry or exit, select the macro from the 

Entry or Exit drop-down list in the field’s Options dialog box. 

caution
 Macro-enabled fields are possible only 
with legacy form fields. They work 
in legacy documents and templates 
(.dot or .doc) and in Word 2010 macro-
enabled templates and documents 
(.dotm and .docm), but not in the regu-
lar “x” file formats (.dotx and .docx). 
It’s not that you can’t associate a macro 
with a field in those file formats, but 
that macros can’t exist in those files, so 
there are no macros to be referenced.  
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  Enabling or Disabling a Field  
In some cases, you might want to prevent users from changing the content of a field. Some would 

argue, “Why use a field at all if the user can’t change it?” But there are reasons for that. For exam-

ple, if you save the form data only to a text file, only what’s in the fields is saved, so you might 

want some fixed values to travel along with the user-entered data. 

To set up a field so that users cannot input anything into it or change its content, open its Options 

dialog box (right-click and select Properties) and clear the Fill-In Enabled check box. 

  Assigning a Bookmark to a Field  
Each field has a default bookmark name so you can refer to that field whenever you reference a 

bookmark. See the section titled “Using a Field to Set Bookmark Text” in Chapter 14, and the sec-

tion “Working with Bookmarks” in Chapter 15, to learn about the various uses for a bookmark. 

To change a field’s default bookmark name, open its Options dialog box (right-click and select 

Properties) and change the text in the Bookmark text box. 

  Adding Help Text  
For legacy form fields, you can create help text that tells the user what to put in the field. With 

content controls, this isn’t necessary because you can customize the placeholder text in the field, 

as you saw earlier in the chapter. But the unfriendly gray boxes of the legacy fields need the extra 

help.

You can set up help to appear in either or both of two ways: in the status bar or in a pop-up win-

dow that appears when the user presses F1 while the insertion point is inside the field. (Pressing 

F1 any other time opens the regular Word Help window.) 

To set up help messages, follow these steps: 

 1. Right-click the field and choose Properties. 

 2. Click Add Help Text. The Form Field Help Text dialog box opens. 

 3. To set up F1 help: 

 a. Click the Help Key (F1) tab. 

 b. Select the option Type Your Own. 

 c. Type the text to appear in the help message (see Figure 16.17).

   d. Click OK. 

 4. To set up status bar help: 

   a. Click the Status Bar tab. 

 b. Select the option Type Your Own. 

IV
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 c. Type the text to appear in the help message. 

 d. Click OK. 

 5. Click OK. 

  Protecting a Form  
You must protect a legacy form to use its fields. With content controls, protecting the form is 

optional but recommended. 

There are several types of document protection, but the type we’re interested in here makes the 

document uneditable except in the form fields. 

 Figure 16.17 
 Set up help text.        

  Creating Consistent Help Messages Across Multiple Forms  

 For simple forms that aren’t part of an extensive form library, you’ll probably want to use Type 
Your Own, as in the preceding steps. However, if you need to reuse the same messages over 
and over across many forms, consider setting up the help messages as AutoText entries and 
then choosing AutoText Entry in step b of step 3 or 4. That way, if you change the help message 
later, all the forms that use it will draw from the same updated version.  

 To create an AutoText entry to serve as a help message, follow these steps:   

  1.   Type the message text in any document.   

  2.   On the Insert tab, choose Quick Parts, Save Selection to Quick Part Gallery.   

  3.   Type a name for the entry in the Name box.   

  4.   Open the Gallery menu and choose AutoText.   

  5.   Click OK to create the entry.    

 Now when you choose AutoText Entry from the field’s Form Field Help Text dialog box, the entry 
you created is on the list of available entries.     
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To protect a form, follow these steps: 

 1. On the Developer tab, click Restrict Editing. The Restrict Formatting and Editing task pane 

opens.

 2. In the Editing Restrictions section, mark the Allow Only This Type of Editing in the Document 

check box. 

 3. Open the drop-down list below the check box and choose Filling In Forms (see Figure 16.18). 

 Figure 16.18 
 Set up protection for the form so that only the fields are editable.        

 4. Click Yes, Start Enforcing Protection. The Start Enforcing Protection dialog box opens. 

  If this button is not available, make sure you are not still in Design Mode. Click Design Mode on 

the Developer tab to turn it off if needed. 

 5. To put a password on the protection (recommended), type the desired password in the Enter 

New Password (Optional) box, and then retype it in the Reenter Password to Confirm box. 

 6. Click OK. 

The Restrict Formatting and Editing task pane remains open; close it if desired by clicking the X in 

its upper-right corner. 

IV
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To remove the protection so you can further edit the form, follow these steps: 

 1. If the Restrict Formatting and Editing task pane is not already displayed, click Restrict Editing 

on the Developer tab. 

 2. Click Stop Protection. 

 3. If you put a password on the protection, a dialog box appears prompting you for the password; 

enter it and click OK. 

  Filling Out a Form  
You will probably want to test your forms as you build them 

to make sure they are user friendly. Filling out a form is a little 

different depending on the field type, so the following sections 

look at the processes separately. 

    Filling Out a Form with Content Controls  
To enter text in a content control, click inside the content control and then type the entry for it (see 

Figure 16.19).

caution
 The form can be tested either in the 
template file or in a document file 
based on it. If you test the form in 
the template, though, make sure you 
do not save your changes with the 
fields filled in.  

 Figure 16.19 
 Type in a content control.        

If the form is protected, the insertion point flashes at the beginning of the document, and clicking 

anywhere in a protected region fails to move the insertion point; it jumps back to the beginning. 

The only areas you can successfully move the insertion point into are the content controls. With 

content controls, however, it is not mandatory that the document be protected to test a field. If the 

document is not protected, you can click anywhere and edit anything, not just the field entries. 

That’s by design; it allows you to put content controls into any document. 

Depending on the options set up for the content control, the content control might go away after 

you enter something into it, or it might become locked against further editing after the initial entry. 
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If either of those conditions is unsatisfactory, you can turn off their options in the content control’s 

Properties.

  Preventing Accidental Content Control Deletion  

 Because the form is not necessarily protected, the possibility exists that a user will accidentally 
delete the content control. To prevent that from happening, you can protect each control from 
deletion by turning on the Content Control Cannot Be Deleted option in the control’s Properties 
dialog box. Follow these steps:   

  1.    Unprotect the form if it is protected, and make sure Design Mode is selected on the 
Developer tab.   

  2.    Select the content control and click Properties on the Developer tab. The Content Control 
Properties dialog box opens.   

  3.   Mark the Content Control Cannot Be Deleted check box.   

  4.   Click OK.      

  Filling Out a Legacy Form  
A legacy form doesn’t work properly unless it’s protected. When unprotected, the form treats the 

fields as foreign objects, and you can’t enter anything into them. 

On a protected form, you can click in a field and then type the text into it, or you can press Tab to 

move from field to field. 

If help has been set up for a field, you can press the F1 key to see the help information when the 

insertion point is within that field. (Pressing F1 any other time opens the general Word 2010 help 

window, not the specific help for that field.) 

  Saving and Printing a Form  
After filling out the form, you will probably want to either save the form input in a file or send the 

completed form to the printer. The following sections explain both of those operations. 

  Saving Only the Form Data  
In Word 2003, you could set a save option in the Save As dia-

log box to save only the form data in a plaintext file. You can’t 

do that from the Save As dialog box anymore, but there’s an 

alternative method you can use. 

To save only the form data in a text file, follow these steps: 

 1. Choose File, Options. The Word Options dialog box opens. 

 2. Click Advanced. 

caution
 If your form contains only Word 
2007/2010 content controls, the 
check box in step 4 is grayed out. If 
the form contains a mixture of con-
tent controls and legacy form fields, 
the check box is available, but the 
resulting save captures only the data 
from the legacy fields.  

IV
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 3. Scroll down to the Preserve Fidelity When Sharing This Document section, and make sure the 

correct document is selected on the list. 

 4. Mark the Save Form Data as Delimited Text File check box and click OK. 

 5. Choose File, Save As. The Save As dialog box opens with Plain Text set as the file type. 

 6. Type a name for the file and click Save to save the text file. 

In the resulting text file, the data is comma-delimited with quotation marks around text entries. For 

example, an address block might look like this: 

“Sheri Harris”,“10783 Westwood Place”,“Anderson”,“IN”,“46282” 

  Printing Only the Form Data  
Printing form data is similar to saving form data, in that it works only with legacy form fields, not 

content controls. When you choose to print only the form data, none of the other text from the form 

prints. However, if the form was constructed within a table, and that table had visible borders or 

shading, the table will print along with the data. (If you don’t want the table to print, set its borders 

to None before printing.) 

To print only the form data, follow these steps: 

 1. Choose File, Options. The Word Options dialog box opens. 

 2. Click Advanced. 

 3. Scroll down to the When Printing This Document section, and make sure the correct document is 

selected on the list. 

 4. Mark the Print Only the Data from a Form check box. 

 5. Click OK. 

 6. Print the document as you normally would. None of the text prints except the text in the form 

fields.

  Tips for Creating Printed Forms  
Some forms end up being used for both onscreen and on-paper data entry. That’s fine, but what 

constitutes an effective online form might not always be the same as what constitutes an effective 

printed form. 

Here are some things to think about when moving between printed and electronic formats: 

 • In an onscreen field, users can enter a lot of data in a small field because the text scrolls within 

the field (at least it does on a legacy form field). When that field is printed, however, there will 

be a limited amount of space for it. Will your users be able to adequately record their entries in 

the space provided? 
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 • Drop-down fields do not work on a printed form, so you must replace them with check boxes 

or option buttons. (See the sidebar “Using Option Buttons on a Form” earlier in this chapter for 

details.)

 • Check boxes might need to be larger on printed forms than on electronic ones. To change the 

size of a check box, right-click it and choose Properties and make the change in its Options dia-

log box. 

 • Calculated fields and fields that insert the current date/time do not work on printed forms, so 

remove them or change them to user-editable fields. 

 • Instead of using a legacy check box field, you might prefer to use a bullet character that looks 

like a check box. If the form will not be submitted electronically, it doesn’t matter that it’s not a 

real field. Also, more formatting options are available with a bullet character. 

IV
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entering, 698-699
inline references, 701-702
temporary placeholders, 

702-703
transferring to/from 

Master List, 701

Click and Type feature, 59-60

clip art 
backgrounds, 465-466
borders, 469-470
captions, 455-456
Clip Organizer, 458

browsing clips, 458
found clip options, 460
moving pictures between 

collections, 462
pictures, adding, 461
scanned images, adding, 

461
searching by keyword, 

459
collection folders, creating, 

460
color-adjusting, 465
converting to Microsoft 

Drawing objects, 472
copying to other 

applications, 452-453
cropping, 465
envelopes, 326
fills, 466
flipping, 471
formats, 451
history, 415
hyperlinks, 589-590
information, viewing, 

453-454
keywords, 452, 455-456
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Microsoft online gallery, 451
modified, moving/resizing, 

473-474
Office Online collection, 

searching, 457-458
offline availability, 454-455
page borders, 286
positioning, 465
resizing, 465
rotating, 471
searching, 452
shadows, 470
shapes

editing, 473
images, 417
moving, 472, 474
recoloring, 473
selecting, 472

text wrapping, 462-463
tight against clips, 463
wrap points, customizing, 

464
transparent color, 467-469
watermarks, 279

Clip Art task pane, 452

Clip Organizer 
optional tools , 899 
saving items to Clipboard, 

66

Clipboards
caret codes (^), 78
clearing, 70
content, saving for later, 66
Office

cutting/copying/pasting
text, 70

deleting items, 70
options, 70
task pane, 70

Windows versus Office, 64

ClipBook Viewer, 66

Close command (File menu), 9

closing task panes, 12

CMYK (Cyan/Magenta/Yellow/
Black), 380-381

coauthoring, 788

collaboration
coauthoring, 788

colors/markings, 761
combining documents,

772-773
comments, 762

adding, 763
deleting, 764
editing, 763-764
viewing, 763-764

comparing documents 
Compare feature, 770
legal blackline, 771-772
viewing documents side 

by side, 769
final documents, 801-802
Full Screen Reading view, 

773-774
moving between screens, 

774-775
options, 776-777
tools, 775-776

Microsoft Office 
Communications Server 
2007 R2, 790

Microsoft Office Live 
Workspace, 777

adding documents to 
workspaces, 781

creating workspaces, 
779-780

editing documents,
782-783

managing workspaces, 
783-784

sharing workspaces,
781-782

signing up, 778-779
Microsoft Office Web Apps, 

789
Microsoft Word Mobile 2010 ,

790
offline, 757
online, 757
Reviewing pane, viewing/

hiding, 758-759
revisions, 764

accepting/rejecting,
767-768

balloons, enabling/
disabling, 765

character-level versus 
word-level, 773

locking, 768
moving between, 767
reviewing, 765-766
turning on/off, 764

SharePoint Workspace 2010 ,
788-789

SkyDrive, 784
configuring, 784-786
document options, 786
uploading documents, 

786-788
tools, 757
tracked changes balloons, 

758-761
usernames, 761-762

collapsing/expanding outlines, 
666

colors
clip art 

adjusting, 465
shapes, recoloring, 473
transparent, 467-469

depth, 381-382
fonts, 158-161

editing, 159-161
fixed versus theme, 159
RGB, 161
tints, 159

hyperlinks, 592-593
models, 380-381
modes (pictures), 398-399
paragraphs

borders, 211
shading, 213-214

revisions, 761
SmartArt diagrams, 533
themes

applying, 248-249
creating, 248-250

Colors dialog box, 160-161

column break caret code, 78

column charts, 486

columns
indexes, 752
multicolumn layouts 

breaks, 282
different settings for 

selected text, 283
presets, 281-282
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settings, customizing, 
282-283

tables
adding, 343-344
deleting, 345
selecting, 63, 342-343
sizing evenly, 353

Columns dialog box, 282-283

COM add-ins, 859, 860, 887

combining documents, 772-773

Combo Box control, 643

commands
File menu 

Close, 9
Help, 9, 17
Help, Check for Updates ,

885
Info, 9
listing of, 8-9
New, 9, 20
Open, 9
Options, 9, 883
Print, 9, 128
Properties, Advanced 

Properties, 44
Recent, 9
Save, 8
Save & Send, 9
Save As, 8

Quick Access toolbar, add-
ing, 6, 864

comments, 762
adding, 763
deleting, 764
editing, 763-764
read-only documents, 799
viewing, 763-764

{Compare} field code, 629-630

comparing documents 
combining documents, 

772-773
Compare feature, 770
legal blackline, 771-772
viewing documents side by 

side, 769

Compress Pictures dialog box, 
395-396

compressing pictures, 395-396

backward-compatible
documents, 396

Word 2010 documents, 
395-396

content controls 
accidental deletion, 658
adding, 642
configuring

building blocks, 647
check box options,

646-647
dates, 646
field-removal, 644
lists, 645
multiparagraph text, 644
settings for all controls, 

643-644
style options, 643-644

filling out, 657-658
legacy fields, compared, 

640-641
placeholder text, 647-648
types, 643

Contents tab, 45

contextual tabs, 6

Continuous section breaks, 254

contrast (pictures), 397

Convert Text to Table dialog 
box, 195, 375

copying
clip art to other applications, 

452-453
documents, 24
folders, 24
macros between documents, 

847-848
outlines, 680
rows (tables), 345-346
styles between documents, 

245-246
tab stops between 

paragraphs, 196
text

dragging-and-dropping,
64

formatting, 65-68,
173-174, 311

Office Clipboard, 70

copyright symbol (©), 54

Corrections button, 397

COUNT() function, 372

cover pages, 264
creating, 264
deleting, 265
saving content as, 265-266
viewing, 265

crashes, 885 -887
add-ins/extensions, dis-

abling, 886-887
document specific , 885 
error reports , 885 
updates, checking , 885 

Create Custom Dictionary 
dialog box, 107

Create New Building Block 
dialog box, 89, 265-266

Create New Style from 
Formatting dialog box,
231-234

Create New Theme Colors 
dialog box, 249

Create New Theme Fonts 
dialog box, 151, 250

{CreateDate} field code, 623

Crop tool, 393

cropping
clip art, 465
pictures, 393-394

Cross-Reference dialog box, 
598

cross-references, 717-718
building blocks, 720
captions, 720
context, 719-720
creating, 718-719
footnotes/endnotes, 720
headings, troubleshooting, 

720
indexes, 726
web pages, 827

CSS (Cascading Style Sheets), 
812, 827

Ctrl+’,’ keyboard shortcut, 55

Ctrl+’,” keyboard shortcut, 55



Ctrl+* keyboard shortcut908

Ctrl+* keyboard shortcut, 181

Ctrl+[ keyboard shortcut, 150

Ctrl+] keyboard shortcut, 150

Ctrl+↑, 61

Ctrl+↓, 61

Ctrl+→, 61

Ctrl+←, 61

Ctrl+A keyboard shortcut, 63

Ctrl+Alt+. keyboard shortcut, 
55

Ctrl+Alt+C keyboard shortcut, 
55

Ctrl+Alt+Num - keyboard 
shortcut, 55

Ctrl+Alt+number keyboard 
shortcut, 237

Ctrl+Alt+Page Down keyboard 
shortcut, 61

Ctrl+Alt+Page Up keyboard 
shortcut, 61

Ctrl+Alt+R keyboard shortcut, 
55

Ctrl+Alt+Shift+Page Down 
keyboard shortcut, 62

Ctrl+Alt+Shift+Page Up key-
board shortcut, 62

Ctrl+Alt+T keyboard shortcut, 
55

Ctrl+Alt+Z keyboard shortcut, 
61

Ctrl+B keyboard shortcut, 162

Ctrl+C keyboard shortcut, 65

Ctrl+End keyboard shortcut, 
61

Ctrl+Enter keyboard shortcut, 
51

Ctrl+F6 keyboard shortcut, 61

Ctrl+F9 keyboard shortcut, 631

Ctrl+F11 keyboard shortcut, 
631

Ctrl+Home keyboard shortcut, 
61

Ctrl+I keyboard shortcut, 162

Ctrl+M keyboard shortcut, 188

Ctrl+Num - keyboard shortcut, 
55

Ctrl+Page Down keyboard 
shortcut, 61

Ctrl+Page Up keyboard 
shortcut, 61

Ctrl+Shift+↑, 63

Ctrl+Shift+↓ keyboard short-
cut, 63

Ctrl+Shift+< keyboard 
shortcut, 150

Ctrl+Shift+> keyboard 
shortcut, 150

Ctrl+Shift+←, 63

Ctrl+Shift+D keyboard 
shortcut, 163

Ctrl+Shift+End keyboard 
shortcut, 63

Ctrl+Shift+F6 keyboard 
shortcut, 61

Ctrl+Shift+F7 keyboard 
shortcut, 631

Ctrl+Shift+F8+arrow keys 
keyboard shortcut, 63

Ctrl+Shift+F11 keyboard 
shortcut, 631

Ctrl+Shift+Home keyboard 
shortcut, 63

Ctrl+Shift+M keyboard 
shortcut, 188

Ctrl+Shift+N keyboard 
shortcut, 237

Ctrl+Shift+P keyboard 
shortcut, 150

Ctrl+Shift+S keyboard 
shortcut, 224

Ctrl+Shift+T keyboard 
shortcut, 189

Ctrl+Shift+W keyboard 
shortcut, 163

Ctrl+T keyboard shortcut, 189

Ctrl+U keyboard shortcut, 163

Ctrl+V keyboard shortcut, 65

Ctrl+X keyboard shortcut, 65

Ctrl+Y keyboard shortcut, 55

Ctrl+Z keyboard shortcut,
53-54

curved lines 
customizing, 425-426
drawing, 419-420

custom properties 
defining, 46-47
editing, 46
updating automatically, 47

Custom tab (Properties dialog 
box), 45,

customization settings 
exporting, 871-872
importing, 872

Customize Address List dialog 
box, 562

Customize Keyboard dialog 
box, 57-58, 838, 872

customizing. See also editing 
AutoCorrect, 111-113
autorecover intervals, 48-49
bulleted lists, 203-207

Bullet Library, 204
new bullets, creating, 204
picture bullets, creating, 

206-207
button galleries, 10
clip art 

captions, 455-456
keywords, 455-456

drawn objects 
arrow heads, 423
curves/scribbles, 425-426
elbows/curved

connectors, 423-425
straight lines, 423

envelopes
address positions, 324
fonts, 324
printer feed orientation, 

325
favorite file locations 

Windows Vista or 7 , 30 
Windows XP, 31

file save locations, 47-49
finding and replacing text, 

75-62
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label specifications, 329-330
mail merges 

advancing to next record, 
584

bookmark text field,
583-584

conditions, 582-583
information collection 

field, 579-580
numbering records, 584
storing information field, 

580-582
paragraph breaks, 214-216
pictures

artistic effects, 400-401
backgrounds, deleting, 

399
brightness/contrast, 397
color modes, 398-399
positions, 391
sharpening/softening,

397-398
Quick Access toolbar, 6
Recent Documents list, 37
research tools, 125-126
Ribbon, 866

adding commands,
869-870

creating tabs, 868
custom groups, creating, 

868
deleting commands, 870
deleting tabs/custom 

groups, 869
minimizing, 866
renaming/reordering

tabs, 870-871
resetting to original, 871
viewing/hiding tabs,

866-867
section breaks, 255
shapes, 426
spelling and grammar 

checker, 100
exceptions, 102
grammar and style 

settings, 103-104
Office spelling options, 

101-102
Word only options, 102

spelling dictionaries 
flagged words, adding, 

104
languages, selecting, 105
multiple words, adding, 

105-106
word list, editing, 104-105

status bar, 873-874
Styles pane, 225-226
symbol bullets, creating, 

204-205
table styles, 355-357
TOCs

basic options, 729
deleting presets, 732
elements to include, 

marking, 730
saving presets, 732
starting, 728-729

watermarks, 278-279
WordArt, 447

cutting
text, 65, 70
TOCs, 731-732

Cyan/Magenta/Yellow/Black
(CMYK), 380-381

cycle diagrams, 518

 D  
Data Connection Wizard dialog 

box, 559

data labels (charts),
476, 491-493

data points (charts), 475

data recovery, 881
AutoRecover options ,

883-884
Document Recovery task 

pane, 881-882
unreadable files , 884 

data series (charts), 475

data sharing 
bookmarks, 593-594

creating, 594-595
cross-references, 598-599
hyperlinks, 595-597
jumping, 595

embedding data, 599-600
entire existing file, 

600-601
new objects, 603
selections of files,

602-603
views, 601

hyperlinks, 586
automatically creating, 

586
bookmarks, 595-597
colors, 592-593
deleting, 592
editing, 591-592
email, 590
executable files, 589
following, 587-588
images, 589-590
new documents, 591
text, creating, 587-589
underlining, 592

{IncludePicture} field, 612
Insert Field command, 

612-613
Insert Picture command, 

612
updating, 612

{IncludeText} field, 609
Insert Field command, 

609-611
Insert Text from File 

command, 609-610
switches, 610
updating, 611-612

links
breaking, 608
disadvantages, 604
embedding, compared, 

604
entire files, 605
linked file changes, 608
manually updating, 608
moving linked files, 604
portions of files, 606-607
update settings, 607

source and destination 
connectivity, 586

data sources (mail merges) 
creating, 561-562
delimited data files, 559
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editing, 563
Excel, 557-558
fields, customizing, 562
fixed-width data files, 555
ODBC, 560-561
Outlook contact lists,

556-557
SQL/Oracle databases, 

559-560
supported sources, 555
Word documents, 558-559

data tables (charts), 
476, 505-506

{Database} field code, 630

datasheets (charts) 
data ranges, editing, 483-484
editing, 484
hidden/empty cells, 484
switching between rows/

columns, 484

Date and Time dialog box, 271

{Date} field code, 623

Date Picker control, 643

dates and times 
field codes, 622-623
headers and footers 

adding, 271-272
syntax rules, 273

legacy fields, 650

decimal tab stops, 192

decrypting folders, 795

Define New Bullet dialog box, 
204

Define New Multilevel List 
dialog box, 677

Define New Number Format 
dialog box, 201

DEFINED(x) function, 372

Delete Cells dialog box, 345

Delete key, 51

deleting
bibliographies, 708
chart templates, 481
commands from Ribbon, 870
comments, 763- 764
cover pages, 265

custom TOC presets, 732
documents, 24
drawing canvas, 421
drop caps, 172
field codes, 268
font styles, 162
footnotes/endnotes, 711
highlighting, 168
hyperlinks, 592
items from Clipboard, 70
list styles, 680
macros, 848
multilevel lists, 680
network share permissions, 

795-796
Office 2010, 897
paragraph borders, 211 -212
passwords, 793
picture backgrounds, 399
print jobs, 139
Quick Styles, 222
research providers, 125-126
Ribbon tabs/custom groups, 

869
section breaks, 255
shapes, 523
sources, 700
styles, 226, 238
subdocuments, 689
tab stops 

ruler, 193
Tabs dialog box, 194

tables
entire tables, 345
rows/columns/cells, 345

text, 52, 173
TOCs, 726

delimited data, 367
mail merges, 559
overview, 555
sorting

not in tables, 368
tables, 367-369

depth axis (charts), 475

Developer tab, 642

dialog boxes 
Add Clips to Organizer, 461
Add Custom Dictionary, 109
Add Fonts, 156
Add/Modify FTP Locations, 

30

Artistic Effects Options, 400
Attach Template dialog box, 

303
AutoCorrect, 176-177

actions, configuring,
116-117

symbols, 57
AutoCorrect Exceptions, 

112-113
AutoFormat, 178-179
Blog Accounts, 830
Bookmark, 594
Borders and Shading 

page borders, 285-286
paragraph borders, 

211-212
table cells, 357, 360-361

Building Blocks Organizer, 
91

Caption, 366, 412
Caption Numbering, 366, 413
Change Chart Type, 486
Colors, 160-161
Columns, 282-283
Compress Pictures, 395-396
Convert Text to Table, 

195, 375
Create Custom Dictionary, 

107
Create New Building Block, 

89, 265-266
Create New Style from 

Formatting,
231-232, 233-234

Create New Theme Colors, 
249

Create New Theme Fonts, 
151, 250

Cross-Reference, 598
Customize Address List, 562
Customize Keyboard, 57-58,

838, 872
Data Connection Wizard, 559
Date and Time, 271
Define New Bullet, 204
Define New Multilevel List, 

677
Define New Number Format, 

201
Delete Cells, 345
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Document Inspector, 807
Drop Cap, 172-173
Edit Citation, 703
Edit Hyperlink, 591
Edit Source, 700
Envelope Address, 324
Envelope Options 

mail merge options, 553
printer feed orientation, 

325
sizes, 323

Envelopes and Labels, 322
E-Postage, 327
full page of same, 327-328

Fax Setup, 141
File Locations, 48
Find and Replace 

customizing, 75-62
finding text, 73
formatting, 77
Go To tab, 81-82
highlighting found text, 

75
replacing text, 76
selecting, 74

Find Duplicates, 575
Font

Advanced tab, 169-170
selecting fonts, 150-151
spacing, 168
styles, 163
underlining, 163

Font Substitution, 158
Format Axis, 496
Format Data Labels, 493
Format Data Series 

data spacing, 514
shape series, 513

Format Error Bars, 504
Format Picture 

3-D rotation, 409-410
glow options, 405

Format Shape 
gradient fills, 441
pattern fills, 443
shadows, 444
SmartArt diagrams, 530
text boxes, 313-314
texture fills, 442

Formatting Restrictions, 799

Formula, 370
Frame, 320
Grammar Settings, 103-104
Hyphenation, 86
Index, 749
Insert Address Block, 551,

565
Insert Cells, 343-344
Insert Chart 

based on templates, cre-
ating, 481

creating charts, 478
Insert Greeting Line, 551,

567
Insert Hyperlink, 587, 823
Insert Picture, 384-385
Insert Table, 337-338
Insert Word Field: Fill-In, 

580
Insert Word Field: IF, 583
Keywords, 455-456
Label Details, 329
Label Options, 329
Layout

chart positions, 485
picture anchors, locking, 

389-390
SmartArt diagrams, 537
text boxes, 310-311

Line Numbers, 262-263
Manage Styles 

default, redefining, 240
filtering styles, 244
options, 241-242
Recommend tab, 243
status, 245

Manual Hyphenation, 88
Mark Index Entry, 742
Merge to E-Mail, 578
Merge to New Document, 

577
Merge to Printer, 577
Microsoft Office Trusted 

Location dialog box, 804
modal, 12
Modify Building Block, 93
Modify Location, 48
Modify Style 

definitions, 239
names, 240

outlines, 668
table styles, 355
templates, 241

New, 301
New Address List, 561
New Blog Account, 829
New Collection, 460
Open

documents, opening, 
38-39

file listing views, 39-40
file types, 40-41
multiple files, selecting, 

39
opening

button drop-down lists, 
12

Ribbon buttons, 10
Organizer, 245-246
Page Number Format, 270
Page Setup 

margins, 257
paper sizes, 260-261
section breaks, 255

Paragraph
alignment, 197
before/after, 186
breaks, 214-216
indentation, 187-188
line spacing values, 

184-185
Paste Special, 69
Picture Bullet, 206
Placeholder Name, 703
Printed Watermark 

customized watermarks, 
278

picture watermarks, 279
Properties

Contents tab, 45
Custom tab, 45
General tab, 45
Statistics tab, 45
Summary tab, 45
template types, 290-291

Recognized Math Functions, 
115

Record Macro, 836
Save As, 24

file management, 24
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save locations in 
Windows Vista or 
Windows 7, 24

Save Chart Template, 480
Save Current Theme, 248
Select Data Source, 483, 558
Select Table, 558
Sign, 810
SmartArt Graphic, 521
Source Manager, 698
Spelling and Grammar, 98

exceptions, 102
Office spelling options, 

101-102
Word only options, 102

Start Enforcing Protection, 
656, 798

Style, 752
Style Pane Options, 225, 245
Symbol, 56-57, 204
tab group associations, 12
Table of Figures Options, 

736
Table Options, 361
Table Positioning, 365
Table Properties 

alignment, 364
cell margins, 362
headings, 363
sizing tables, 351-352
text wrapping, 365

Tabs, 193-194
Text Effects 

3D, 166
filling, 164
glowing, 166
outlining, 164-166
reflections, 166
shadows, 166

Track Changes Options, 759
Trust Center, 805
Web Options, 816

Browsers tab, 816-817
Encoding tab, 820
Files tab, 818-819

Word Options 
Cut, Copy, and Paste sec-

tion, 67-68
embedding fonts, 157-158
printing, 135-136

spelling and grammar 
checker, 101

substituting font, 158
Zoom, 16

dictionaries, 104
adding to Word, 108-109
creating, 106-107
default, 104, 107
enabling/disabling, 107
Encarta Dictionary, 118-119
exclusion, 107-108
flagged words, adding, 104
languages, selecting, 105
multiple words, adding,

105-106
word list, editing, 104-105

digital photography, 379
bitmap images, 379
charge-coupled device 

(CCD), 379
color depth, 381-382
color models, 380-381
file formats, 382
image resolution, 382-383
pictures

3-D effects, 406-407
3-D rotation, 409-410
accepted formats,

385-386
artistic effects, 400-401
backgrounds, deleting, 

399
bevels, 406-407
borders, 410-411
brightness/contrast, 397
captions, 412-413
color modes, 398-399
compressing, 395-396
cropping, 393-394
glow, 406
inserting from files, 

384-386
positioning, 388-391
presets, 402-403
reflection, 405
resizing, 392-393
rotating, 407-408
shadows, 403-405
sharpening/softening,

397-398

sizes, 380
SmartArt, applying, 

410-412
soft edges, 406
styles, applying, 401
text wrap, 386-388

Word compatibility, 383-384

digital signatures, 809-810
adding, 810
invalid, troubleshooting, 810
reviewing, 810
third-party certificates, 492

directories
mail merges, 548
merge fields, 569-570
previewing, 569-570

disabling
add-ins, 860, 886-887

actions, 842
COM, 861

automatic hyphenation, 86
custom dictionaries, 107
extensions, 886 -887
global templates, 304
hyperlinks

automatic creation, 586
Ctrl+click activation,

587-588
legacy fields, 654
linked styles, 225
research services, 126-127
revision balloons, 765
smart paragraph selection, 

60

displaying. See viewing 

distributing objects, 433-434

.doc extension, 35

.docm extension, 35

{DocProperty} field code, 624

Document Inspector dialog 
box, 807

document maps, viewing, 
82-83

Document Properties bar, 44

Document Recovery task pane, 
881-882
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documents
adding to workspaces, 781
automation fields, 629-630
automatically backup 

copies, 884
AutoRecover

locations, 877-878
options, 883 -884
overview, 881

AutoSaved, opening/
saving, 882

blocking, 806-807
Building Blocks.dotx corrupt 

file, 91
combining, 772-773
comparing

Compare feature, 770
legal blackline, 771-772
viewing documents side 

by side, 769
conversions

confirming, 891
Microsoft Works, 890
previous versions, 889-890 
unsupported file formats ,

891
Word 2007/2010 format, 

37
WordPerfect, 890-891

copying
macros between, 847-848
Save As dialog box, 24
styles between, 245-246

creating
blank, 20-21
existing documents, 297
Office Online templates, 

293-295
sample templates, 292
template based, 22-23
user templates, 295-296

default settings, 19
deleting, 24
document-wide settings, 253
favorite locations, 30
faxing. See faxing 
final, marking, 801-802
formats, 31-36

backward compatibility, 
34

converting to Word 
2007/2010 format, 37

default save, 48
editing, 34
extensions, viewing, 31
listing of, 35
naming convention, 33
pictures, 382, 385-386
web pages, 812-813
XML based, 31

information field codes, 
623-624

.lex
opening in Notepad, 108

location preferences 
default, customizing, 

47-49
save locations in 

Windows Vista or 
Windows 7 , 24 

save locations in 
Windows XP, 26

as mail merge data sources, 
558-559

moving, 24
multiple

arranging, 16
switching between, 16
viewing, 16-17

navigating
insertion point, moving, 

59-60
keyboard shortcuts, 60-61
scrolling, 59

opening, 37
file types, 40-41
nonsupported file types, 

41
Open dialog box, 38-39
recently used, 37-38
special modes, 41-42

printing, 128
both sides of paper,

131-132
collation, 130
content, scaling, 136
copies, selecting, 129-130
default settings, 128
draft quality, 135
field codes, 136
form data, 136
information sheets, 130

margins, 133
multiple pages per sheet, 

133
orientation, 132
page order, reversing, 

136
pages, selecting, 130
paper size, 132-133
PostScript over text, 136
Print Preview, 133-134
printers, selecting,

128-129
properties, 128
trays, selecting, 136
Word options, 135-136
XML tags, 136

properties, 43, 135
protecting

encryption. See
encryption

network share permis-
sions, deleting, 795-796

password-protecting,
792-793

read-only
comments, allowing, 799
creating, 796-797
editing restrictions, 

797-798
form fields, filling in, 799
per-user exceptions,

800-801
recommending, 796
revision marks, forcing 

on, 799
style restrictions, 799-800

recovering, 881
AutoRecover options, 

883-884
Document Recovery task 

pane, 881-882
unreadable files, 884

saving, 24
autorecover intervals, 

customizing, 48-49
default format, 

48, 892-893
default save locations, 

setting, 47-49
favorite locations, 30-31
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file formats, 31-36
FTP sites, 29-30
locations, 877-878
network locations, 27-28
as read-only, 42-43
save locations in 

Windows Vista or 
Windows 7, 24

save locations in 
Windows XP, 26

web format, 34-36
web locations, 29
web pages, 815-816

searching
document maps, 82-83
Go To tab, 81-82
Select Browse Object fea-

ture, 80
sections. See sections 
sharing, 891 -892
startup, 19
uploading to SkyDrive,

786-788
vertical alignment, 261-262
viewing

Draft, 14
Full Screen Reading, 14
Outline, 14
Print Layout, 13
switching, 14-15
Web Layout, 14
without Word, 893-894

WordML, 31,
zooming in/out, 15-16

View tab, 15-16
Zoom slider, 15

{DocVariable} field code, 630

.docx extension, 35

.dot extension, 35

.dotm extension, 35

.dotx extension, 35

double closing/opening quote 
(“), 54

double strikethrough effect, 
165

double-headed arrow (↔), 54

doughnut charts, 486

downloading Office Online 
templates, 294

Draft view, 14

dragging-and-dropping
rows (tables), 345-346
text, 64

drawing
canvas, 420-422

backgrounds, 420
creating, 420
default when drawing, 

420
deleting, 421
formatting, 422
resizing, 421-422

flipping objects, 427
lines, 419-420

arrow heads, 423
customizing, 423
elbows/curved connec-

tors, 423-425
polygons, 420
rotating objects, 427
shapes, 417-418

customizing, 426
text, adding, 422-423

tables, 338-339
text boxes, 309
WordArt

alignment, 451
applying to regular text, 

448
creating, 446
customizing, 447
fills, 450
formatting, 448
new features, 446
outlining, 450
shapes, 448-449
text wrapping, 448
too much text, 448
vertical text direction, 450

drawings
grouping, 432-433
printing, 135
vector

bitmaps, compared, 
415-416

functions, 417
sizes, 416

drivers
Image Writer, 34
multiple print, configuring, 

138

Drop Cap dialog box, 172-173

drop caps, 170
creating, 172
deleting, 172
Dropped-style, 170-172
In-Margin, 170-172
options, 172-173

Drop-Down List control, 643

drop-down lists, buttons, 12

Dropped-style drop caps, 
170-172

dummy text 
adding, 89
overview, 88

duplexing, 131-132

 E  
Edit Citation dialog box, 703

Edit Hyperlink dialog box, 591

Edit Source dialog box, 700
editing. See also customizing 

AutoCorrect entries, 113
bibliographies, 707
blog posts, 831
building block properties, 93
charts

data ranges, 483-484
datasheet, 482-483
types, 486

citations, 703-704
comments, 763-764
custom properties, 46
data sources, 563
documents in workspaces, 

782-783
field codes, 621
file formats, 34
font colors, 159-161
hyperlinks, 591-592
macros in Visual Basic 

Editor, 851-856
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character formatting, 
applying, 852-853

inserting graphics 
example, 852

logical condition actions, 
855-856

opening macros, 851
performing same actions 

in different ways,
853-854

multilevel lists, 673
Office 2010 installation, 897
Quick Style sets, 221-222
sources, 699-700
spelling dictionary word list, 

104-105
styles, 219, 241-242
subdocuments, 688
templates, 300
text

case, 167
SmartArt diagrams, 525
spacing, 168

theme fonts, 151-153

{EditTime} field code, 623

effects
artistic effects, 400-401
charts. See charts, effects 
fonts, 164

3D, 166
all caps, 165
double strikethrough, 165
filling, 164
glowing, 166
hidden, 165-164
outlining, 164-166
shadows, 166
small caps, 165
strikethrough, 165
subscript, 165
superscript, 165

pictures
3-D rotation, 409-410
bevels, 406-407
glow, 406
reflections, 405
shadows, 403-405
soft edges, 406

text, 164
3D, 166

all caps, 165
double strikethrough, 165
filling, 164
glowing, 166
hidden, 165-164
outlining, 164-166
reflections, 166
shadows, 166
small caps, 165
strikethrough, 165
subscript, 165
superscript, 165

ellipsis, 54

em dashes (—), 54, 78

email
forms, 648
hyperlinks, 590, 823-824
mail merges, 548
sending from Word, 831

embedding
data, 599-600

entire existing file,
600-601

new objects, 603
selections of files, 

602-603
views, 601

fonts, 157-158

en dashes (–), 54, 78

enabling
add-ins, 860

actions, 842
COM, 861

automatic hyphenation, 86
custom dictionaries, 107
global templates, 304
legacy fields, 654
research services, 126-127
revision balloons, 765

Encarta Dictionary, 118-119

encryption, 793-794
decrypting folders, 795
folders, 794
permissions, 794

End key, 61

endnote mark caret code, 78

endnotes
adding, 711
cross-references, 720
deleting, 711
footnotes, compared, 708
jumping, 711
moving between, 712
numbering/symbols, 714
positioning, 713-714
reference marks, placing, 

709
separator lines, 715-717
styles, 714-716
switching between foot-

notes, 713

end-of-file markers, 51

Enter key, 51

entering text, 51
Insert mode versus Overtype 

mode, 53
line breaks versus paragraph 

breaks, 52
symbols, inserting 

keyboard shortcuts/
AutoCorrect shortcuts, 
54-55

Symbol dialog box, 56

Envelope Address dialog box, 
324

Envelope Options dialog box 
mail merge options, 553
printer feed orientation, 325
sizes, 323

envelopes
address positions, custom-

izing, 324
creating, 322
E-Postage, 326-327
fonts, 324
graphics, 326
mail merges, 548, 552- 554
printer feed orientation, 325
printing, 324
retrieving addresses, 326
sizes, 323-324
storing addresses, 326

Envelopes and Labels dialog 
box

envelopes, 322
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E-Postage, 327
labels, 327-328

E-Postage, 326-327

{Eq} field code, 626

equal to operator (=), 370

Equation Editor, 899

Equation Gallery, 544

Eraser, 347

error bars (charts), 502-504

error reports, 885

evaluating readability 
Flesch-Kincaid Grade Level, 

84
Flesch Reading Ease, 84

Even Page section breaks, 254

Excel
copying into Word tables, 

376-377
mail merge data source, 

557-558
worksheets, embedding, 

377-378

exclusion dictionaries, 107-108

expanding/collapsing outlines, 
666

exponential trendlines, 501

exporting customization 
settings, 871-872

Extensible Markup Language. 
See XML 

extensions (files) 
disabling, 886 -887
listing of, 35
viewing, 31

 F  
F6 key, 61

F8 key, 64

F9 key, 631

F11 key, 631

Factiva iWorks, 120

FALSE() function, 372

favorite file locations, custom-
izing

Windows Vista or 7, 30
Windows XP, 31

Fax Setup dialog box, 141

faxing, 141
fax modems, 141

Windows Vista or 7 ,
141-142

Windows XP, 142-143
Internet faxing services, 143

field caret code, 78

field codes 
adding, 616-618
{Ask}, 580-582
converting to plain text, 633
date and time, 273, 622-623
deleting, 268
documents

automation, 629-630
information, 623-624

editing, 621
equation/formula, 626-627
{FillIn}, 579-580
formatting

custom date and time 
format, 634

custom numeric formats, 
634-636

fonts, 634
locking, 634
numbering, 634-635

frames, 319
headers and footers, 268-269
If...Then...Else, 582-583
{IncludePicture}, 612

Insert Field command, 
612-613

Insert Picture command, 
612

updating, 612
{IncludeText}, 609

creating, 609-611
Insert Text from File com-

mand, 609-610
switches, 610
updating, 611-612

indexes, 627
{Index} code, 748
troubleshooting, 742

viewing/hiding, 742-743
{XE} codes, 746

keyboard shortcuts, 631
links, 628
listing of, 617
locking, 632
mail merges, 630-631
manually typing, 619-620
{MergeRec}, 584
{MergeSeq}, 584 
nesting, 621-622
{NextRecord}, 584
{NextRecordIf}, 584
numbering, 625-626
options, 616-619
overview, 615
printing, 136
properties, 616-619
references, 627-628
searching, 633
{Set}583-584
{SkipRecordIf}, 584
tables, 627
text boxes, 319
TOCs, 727-728, 731-733
troubleshooting

syntax errors, 619
updates, 631

updating, 613, 631
before printing, 135
locking against, 632
printing, 633

user information, 625
views, toggling, 621

figure captions, 735-736

File Locations dialog box, 48

File menu 
commands

Close, 9
Help, 9, 17
Help, Check for 

Updates885
Info, 9
listing of, 8-9
New, 9, 20
Open, 9
Options, 9, 883
Print, 9, 128
Properties, Advanced 

Properties, 44
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Recent, 9
Save, 8
Save & Send, 9
Save As, 8

opening, 8

{FillIn} field code, 579-580, 630

filling out forms, 657-658

fills
backgrounds, 283-284
clip art, 466
drawn objects 

gradient, 439-441
pattern, 443-444
picture, 438-439
solid, 435-438
texture, 442

fonts, 164
paragraphs, 213-214
text boxes, 312
WordArt, 450

filtering
merge records, 571-573
styles list, 244-245

final documents, 801-802

Find and Replace dialog box 
customizing, 75-62
formatting, 77
Go To tab, 81-82
text

finding, 73
highlighting found, 75
replacing, 76
selecting found, 74

Find Duplicates dialog box, 
575

Find What text caret code, 78

finding and replacing, 71-72.
See also searching 

formatting, 77
special characters, 78-79

caret codes (^), 78
text string codes, 79

text
customizing, 75-62
Find and Replace dialog 

box, 73
highlighting all found, 75
Navigation pane, 72

replacing, 76
selecting all found, 74

fixed colors (fonts), 159

Flesch-Kincaid Grade Level, 84

Flesch Reading Ease, 84

flipping
clip art, 471
objects, 427

floors (charts), 475

folded note cards, 331
greeting card templates, 332
paper selection, 332-333
quarter-fold note cards, 

printing, 331
upside-down text, creating, 

333-334

folders
clip art collection, creating, 

460
copying, 24
decrypting, 795
encrypting, 794
moving, 24
templates, saving, 294-295
workgroup templates, 

298-299

following hyperlinks, 587-588

Font dialog box 
Advanced tab, 169-170
selecting fonts, 150-151
spacing, 168
styles, 163
underlining, 163

Font Substitution dialog box, 
158

fonts
assigning, 146
case

Capitalize Each Word 
option, 166

Change Case feature, 167
changing, 167

colors, 158-161
editing, 159-161
fixed versus theme, 159
RGB, 161
tints, 159

default, 146, 151-153
selecting, 151
theme fonts, 151-153

effects, 164
3D, 166
all caps, 165
double strikethrough, 165
filling, 164
glowing, 166
hidden, 165-164
outlining, 164-166
reflections, 166
shadows, 166
small caps, 165
strikethrough, 165
subscript, 165
superscript, 165

embedding, 157-158
envelopes, 324
field codes, 634
Font dialog box, 150-151
Font list, troubleshooting, 

148
formatting, 146
installing, 154-156

Windows 7 , 155 
Windows Vista, 156
Windows XP, 156

multilevel lists, 674
numbered lists, 200
OpenType versus TrueType, 

153-154
PDF documents, 154
printer-resident, 154
printing, 152
Reveal Formatting task 

pane, 146
selecting, 147-148
sizes, 149-151
SmartArt diagram text, 526
styles, 161

applying, 162-163
character styles, com-

pared, 161
deleting, 162
true versus false, 161-162

themes, 148
applying, 250-251
creating, 250-251
troubleshooting, 251
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underlining, 163-164
web pages, 820
WordML codes, 146

footers. See headers and 
footers

Footnote mark caret code, 78

footnotes
adding, 710
continuations, 717
cross-references, 720
deleting, 711
disappearing, 717
endnotes, compared, 708
jumping, 711
key features, 708-709
moving between, 712
numbering/symbols, 714
positioning, 713-714
reference marks, placing, 

709
separator lines, 715-717
styles, 714-716
switching between end-

notes, 713

Format Axis dialog box, 496

Format Data Labels dialog 
box, 493

Format Data Series dialog box 
data spacing, 514
shape series, 513

Format Error Bars dialog box, 
504

Format Painter, 173-174

Format Picture dialog box 
3-D rotation, 409-410
glow options, 405

Format Shape dialog box 
gradient fills, 441
pattern fills, 443
shadows, 444
SmartArt diagrams, 530
text boxes, 313-314
texture fills, 442

Format tab 
Artistic Effects button, 400
Rotate button, 408

formatting
clip art, 451
copying/pasting text, 65-68

Paste button menu 
options, 65-66

Paste Options floating 
icon, 67

Word Options dialog box, 
67-68

documents, 31-36
backward compatibility, 

34
converting to Word 

2007/2010 format, 37
default, 48, 892-893
editing, 34
extensions, viewing, 31
listing of, 35
naming convention, 33
pictures, 382, 385-386
sharing with other pro-

grams, 891 -892
web pages, 812-813
XML based, 31

drawing canvas, 422
drawn objects 

3-D effects, 445-446
3-D effects/shadows 

combination, 446
borders, 435-436
gradient fills, 439-441
pattern fills, 443-444
picture fills, 438-439
Quick Styles, 434
shadows, 444-445
solid fills, 435-438
texture fills, 442

field codes 
custom date and time for-

mat, 634
custom numeric formats, 

634-636
fonts, 634
locking, 634
numbering, 634-635

finding and replacing, 77
fonts, 146

colors, 158-161
default, 151-153
effects, 164
Font dialog box, 150-151

Reveal Formatting task 
pane, 146

selecting, 147-148
sizes, 149-151
styles. See fonts, styles 
underlining, 163-164
WordML codes, 146

frames, 320
indexes, 752

columns, 752
headings, 753-754
languages, 752
page number alignment, 

752
types, 751-752

labels, 329-331
legacy fields 

check boxes, 651
dates and times, 650
help text, 654-655
lists, 653
math calculations,

650-651
text, 649-650

marks, viewing, 875
numbered lists, 200-203

alignment, 201
custom, creating, 201-203
fonts, 200
number styles, 200
Numbering Library, 

201-202
symbols, 201

numbers, 370
page numbers, 270-271
paragraphs

borders, 211-212
end-of-paragraph

markers, 183
inheriting from preceding 

paragraphs, 182
table captions, 366-367
WordArt, 448

Formatting Restrictions dialog 
box, 799

forms, 637
ActiveX controls, 651
content controls 

accidental deletion, 658
adding, 642
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building block options, 
647

check box options,
646-647

dates, 646
field-removal options, 644
legacy fields, compared, 

640-641
lists, 645
multiparagraph text 

options, 644
placeholder text, 647-648
settings for all controls, 

643-644
style options, 643-644
types, 643

creating, 638-639
data, printing, 136
Developer tab, 642
emailing, 648
filling out 

content controls, 657-658
legacy fields, 658

help message consistency, 
654

legacy fields 
adding, 649
bookmarks, 654
check boxes, 651
dates and times, 650
defined, 648
enabling/disabling, 654
help text, 654-655
lists, 653
macros, 653
math calculations,

650-651
properties, viewing, 649
text options, 649-650
tools, 648
types, 648

option buttons, 651
printing

data only, 659
tips, 659-660

protecting, 655-657
saving

data only, 658-659
as templates, 639-640

Formula dialog box, 370

Forward button (Help win-
dow), 17

fractions, 171

Frame dialog box, 320

frames
field codes, 319
formatting, 320
text boxes 

compared, 320
conversions, 319

Freeform tool, 420

FTP sites, 29-30

Full Screen Reading view, 14,
773-774

moving between screens, 
774-775

options, 776-777
tools, 775-776

 G  
galleries, buttons 

customizing, 10
viewing, 11

GB7714 2005 citation style, 696

General tab (Properties dialog 
box), 45

global templates 
applying, 303-304
disabling, 304
enabling at startup, 304
loading at startup, 304

glow
charts, 511
pictures, 406
text, 166

Go To tab (Find and Replace 
dialog box), 81-82

GOST citation style, 696

{GoToButton} field code, 630

gradient fills, 283, 439-441

grammar checking 
customizing, 100

exceptions, 102
grammar and style set-

tings, 103-104

Word only options, 102
fixing errors, 97-98
interactive spelling and 

grammar check, 98-100

Grammar Settings dialog box, 
103-104

Graphic caret code, 78

greater than operator (>), 370

greater than or equal to 
operator (>=), 370

greeting card templates, 332

greeting lines, 567-568

{GreetingLine} field code, 630

gridlines
charts, 498-499
viewing/hiding, 15

grouping shapes, 432-433

gutters, 258

 H  
hanging indents, 197

headers and footers, 266
building blocks, 267-268
content association, 276, 277
dates and times 

adding, 271-272
syntax rules, 273

document properties, 274
field codes, 268-269
master documents, 681-683
multiple, 275-276
page numbering 

adding, 269-270
formatting, 270-271

pictures, 275
positioning, 274
switching between, 266
text boxes, adding, 276
viewing, 266-267

headings
indexes, 753-754
styles, 220
tables, 363

Help
buttons, 17-18
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hyperlinks, 19
navigating, 17-18
offline, 17
opening, 17
searching, 18-19

Help, Check for Updates 
command (File menu), 885

Help command (File menu), 
9, 17

Help icon, 17

hidden text, printing, 135

hiding
gridlines, 15
indexing codes, 742-743
Navigation pane, 15
Reviewing pane, 758-759
Ribbon tabs, 866-867
ruler, 15
text, 164-165

hierarchy diagrams, 517

HighBeam Research, 121

highlighting
found text, 75
text, 167-168

Home button (Help window), 
18

Home key, 61

Home tab 
Bullets button, 203
Bullets/Numbering buttons, 

198
Change Styles button, 221
Indent buttons, 188-189
Line and Paragraph Spacing 

button, 183
Shading button, 213
Show/Hide button, 182
text case, changing, 167
text formatting, deleting, 173

horizontal alignment 
(WordArt), 451

Hosted Webs, 899

HSL (Hue/Saturation/
Luminosity), 161

.htm extension, 35

HTML (Hypertext Markup 
Language), 812

.html extension, 35

hyperlinks, 586
automatically creating, 586
bookmarks

another document, 597
same documents as 

reference, 596-597
colors, 592-593
deleting, 592
editing, 591-592
email, 590
executable files, 589
field code, 628
following, 587-588
Help, 19
images, 589-590
new documents, 591
text, 587-589
underlining, 592
web pages, 821

email, 823-824
images, 822-823
text, creating, 822

Hypertext Markup Language 
(HTML), 812

hyphenation
automatic

defined, 86
enabling/disabling, 86

excluding paragraphs, 87
manual

defined, 86
inserting, 87-88

Hyphenation dialog box, 86

 I  
{If} field code, 630

If...Then...Else field code,
582-583

IF(x, y, z) function, 372

Image Writer driver, 34

importing customization 
settings, 872

{IncludePicture} field, 612, 628
creating

Insert Field command, 
612-613

Insert Picture command, 
612

updating, 612

{IncludeText} field, 609, 628
creating

Insert Field command, 
609-611

Insert Text from File 
command, 609-610

switches, 610
updating, 611-612

Indent buttons, 188-189

indenting
lists, 208
paragraphs, 187

increments, 187
Indent buttons, 188-189
keyboard shortcuts,

188-189
Page Layout tab, 187
Paragraph dialog box, 

187-188
ruler, 189-190

Index dialog box, 749

{Index} field code, 748

indexes, 740-741
AutoMarking entries, 

746-747
codes

troubleshooting, 742
viewing/hiding, 742-743

colons/quotation marks, 742
conventions, 741
cross-references, 745-746
field codes, 627

{Index} field code, 748
{XE} field codes, 746

formatting, 752
columns, 752
headings, 753-754
languages, 752
page number alignment, 

752
types, 751-752

generating
selected alphabet letters, 

751
selected entries, 750-751
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marking entries, 741-742
manually, 742-743
multiple instances of 

same text, 746
master documents, 683
multiple documents, 754
multiple in single document, 

754-755
spell checking, 749
styles, 752-753
subentries, 744-745
troubleshooting

marked entries not 
showing, 745

page numbering, 749
updating, 749

Info command (File menu), 9

inline references to sources, 
701-702

In-Margin drop caps, 170-172

Insert Address Block dialog 
box, 551, 565

Insert Caption button, 366

Insert Cells dialog box, 343-344

Insert Chart dialog box 
based on templates, creat-

ing, 481
creating charts, 478

Insert Greeting Line dialog 
box, 551, 567

Insert Hyperlink dialog box, 
587, 823

Insert mode, 53

Insert Picture dialog box,
384-385

Insert tab, Shapes button, 417

Insert Table dialog box,
337-338

Insert Word Field: Fill-In 
dialog box, 580

Insert Word Field: IF dialog 
box, 583

insertion points, 51, 59-60

installing
fonts

Windows 7 , 155 

Windows Vista, 156
Windows XP, 156

Microsoft Fax, 142
Office 2010 , 895 -897

editing, 897 
file locations , 896 -897
installation options , 896 
optional tools , 898 -899
user information , 897 

INT function, 372

interactive spelling and 
grammar check, 98-100

Internet faxing services, 143

iron-on transfers, printing, 
138-139

ISO 690 First Element and Date 
citation style, 696

ISO 690 Numerical Reference 
citation style, 696

 J  
JavaScript, 812

justified alignment, 197

justified vertical alignment, 
262

 K  
Keep on Top button (Help win-

dow), 18

kerning text, 169-170

keyboard
Backspace key, 51
Delete key, 51
End key, 61
Enter key, 51
F6 key, 61
F8 key, 64
F9 key, 631
F11 key, 631
Home key, 61
Page Down key, 61
Page Up key, 61
shortcuts, 340

Apply Styles pane, 224
Ctrl+Enter keyboard 

shortcut, 51

cutting/copying/pasting
text, 65

defining, 872-873
field codes, 631
font sizes, 150
font styles, 162
heading styles, 220
indenting paragraphs, 

188-189
macro assignments,

838-840, 848-849
navigation, 60-61
nonprinting characters, 

viewing, 182
outline demoting/

promoting, 663
printing properties, 128
redoing text, 54
rejecting automatic 

corrections, 110
Shift+Enter keyboard 

shortcut, 51
styles, 237
symbols, creating, 57-58
text selection, 62
underlining text, 163
undoing text, 53-54

symbol shortcuts, 54-55
Tab key, 51, 61

keywords (clip art), 
customizing, 455-456

Keywords dialog box, 455-456

Keywords field, 44

 L  
Label Details dialog box, 329

Label Options dialog box, 329,
554

labels
formatting, 329-331
mail merges, 548

merge fields, 568-569
options, 554-555

printing
full page of same, 327-328
single labels, 329
special paper, 327

specifications, customizing, 
329-330
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Language Settings Tool , 899 

languages
indexes, 752
spelling and grammar 

checker, 96-97, 109-110
spelling dictionaries, 105
translating, 122

entire documents, 123
languages, selecting, 122
Mini-Translator, 123-124
options, configuring,

124-125
Research pane, 123
WorldLingo website, 122

layering objects with text, 
431-432

Layout dialog box 
chart positions, 485
picture anchors, locking, 

389-390
SmartArt diagrams, 537
text boxes, 310-311

Layout tab, buttons 
AutoFit, 350
Merge Cells, 346
Split Cells, 347
Text Direction, 363

leaders, 193

leading, 185

left alignment, 197

left paragraph indentation, 187

left tab stops, 192

legacy fields 
adding, 649
bookmarks, 654
check boxes, 651
dates and times, 650
defined, 648
enabling/disabling, 654
filling out, 658
help message consistency, 

654
help text, 654-655
lists, 653
macros, 653
math calculations, 650-651
properties, viewing, 649
text options, 649-650

tools, 648
types, 648

legends (charts), 475, 490-491
positioning, 490-491
presets, 490

less than operator (<), 370

less than or equal to operator 
(<=), 370

letter mail merges, 548
address blocks, 550-551, 549
built-in merge blocks, 550
completing, 551
greeting lines, 551
Mail Merge Wizard, starting, 

549-548
opening in new document, 

551-552
previewing, 551
printing, 551
recipients, selecting, 549-550

.lex files, 108

Line and Paragraph Spacing 
button, 183

line charts, 480-486

Line Numbers button, 262

Line Numbers dialog box,
262-263

linear trendlines, 501

lines
anchoring to shapes, 429-431
customizing, 423

arrow heads, 423
elbows/curved connec-

tors, 423-425
drawing, 419-420
numbering, 262-263
positioning, 429
sizing, 427-428
spacing

before/after, 185-186
precise values, 184-185

text-wrapping, 429

lines of text 
breaks

creating, 181
paragraph breaks, 

compared, 52

selecting, 63, 62
spacing, 183-184

{Link} field code, 628

linked styles, 218
creating, 234
disabling, 225

linking
data

breaking links, 608
disadvantages, 604
embedding, compared, 

604
entire files, 605
field codes, 628
linked file changes, 608
manually updating, 608
moving linked files, 604
portions of files, 606-607
update settings, 607

multilevel lists, 675
text boxes, 315-316

list diagrams, 517

{ListNum} field code, 626

lists
bulleted

creating with AutoFormat 
As You Type, 198-199

creating with Bullets 
button, 198

customizing, 203-207
indents, 208
numbered lists, 

compared, 197
SmartArt diagrams, 

adding, 524
hanging indents, 197
levels, editing, 206-208
numbered

bulleted lists, compared, 
197

creating with AutoFormat 
As You Type, 198-199

creating with Numbering 
button, 198

formatting, 200-203
indents, 208
restarting/continuing,

199-200
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starting at specific 
numbers, 200

spacing, 208
styles, 218, 680
tabbed, converting to tables, 

195-196
tabs, 191

local templates, accessing, 23

locking
field codes, 632
picture anchors, 389-390
Quick Style sets, 222
revisions, 768
subdocuments, 692

logarithmic trendlines, 501

 M  
{MacroButton} field code, 630

macros, 833
assigning, 838

keyboard shortcuts, 
838-840

toolbar buttons, 840-841
assigning existing 

keyboard, 848-849
toolbar buttons, 850

automating, 842
AutoOpen, 305-306
copying between docu-

ments, 847-848
creating, 835
deleting, 848
editing in Visual Basic 

Editor, 851-856
character formatting, 

applying, 852-853
inserting graphics 

example, 852
logical condition actions, 

855-856
opening macros, 851
performing same actions 

in different ways,
853-854

legacy fields, 653
names, 837, 848
opening in another template, 

846

planning, 835-836
recording, 836

steps, 841-842
stopping, 843

running, 843-842
security, 857

settings, customizing, 
858-859

trusted publishers/
locations, 857-858

storing, 837-838
tasks, automating, 833-834
troubleshooting, 844-845

availability, 844
runtime errors, 845
viewing, 837

virus protection, 802
macro settings, 804-805
nonmacro file formats, 

selecting, 802
trusted locations, 802-804
trusted publishers, 804

mail merges 
address validation, 575
configuring, 548
custom

advancing to next record, 
584

bookmark text, 583-584
conditions, 582-583
information collection 

field, 579-580
numbering records, 584
storing information field, 

580-582
data files, 547
data sources 

creating, 561-562
delimited data files, 559
editing, 563
Excel, 557-558
fields, customizing, 562
fixed-width data files, 555
ODBC, 560-561
Outlook contact lists, 

556-557
SQL/Oracle databases, 

559-560
supported sources, 555
Word documents, 558-559

directories, 548
merge fields, 569-570
previewing, 569-570

email messages, 548
envelopes, 548, 553-554
error checking, 576
fields, 630-631

address blocks, 565-567
greeting lines, 567-568
individual fields, 564-565

labels, 548
merge fields, 568-569
options, 554-555

letters, 548
address blocks, 550-551,

549
built-in merge blocks, 550
completing, 551
greeting lines, 551
Mail Merge Wizard, 

starting, 549-548
opening in new docu-

ment, 551-552
previewing, 551
printing, 551
recipients, selecting, 

549-550
Mailings tab, 548-549
main documents, 547

preparing, 563-564
selecting, 552-553

merging
email, 578
new documents, 577
printers, 577-578

overview, 547
previewing, 576
records

advancing to next, 584
duplicate, finding, 

574-575
excluding, 570
filtering, 571-573
numbering, 584
searching, 574
sorting, 573-574

templates, 563

Mailings tab, 548-549

main documents (mail merges) 
preparing, 563-564
selecting, 552-553
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Manage Styles dialog box 
default, redefining, 240
filtering styles, 244
options, 241-242
Recommend tab, 243
status, 245

managing
blogs, 830-831
chart templates, 481
workspaces, 783-784

manual hyphenation 
defined, 86
inserting, 87-88

Manual Hyphenation dialog 
box, 88

manual line break caret code, 
78

manual page break caret code, 
78

margins, 256
book folds, 258-259
cells (tables), 361

individual cells, 362
internal table margins, 

361
gutters, 258
precise values, 257
presets, 256-257
printing, 133
text boxes, 313-314

Margins button, 256

Mark Index Entry dialog box, 
742

master documents, 680-681
captions, 683
crashing Word, 682
headers and footers, 681-683
indexes, 683
numbered notes, 683
paginating, 694
printing, 694
styles, 681
subdocuments

adding, 684-685
creating, 685-686
deleting, 689
editing, 688
locking/unlocking, 692

merging, 690-691
moving, 689
nesting, 691-692
renaming, 690
splitting, 692
unlinking, 689-690
viewing/collapsing, 687

TOCs, 683

math calculations 
AutoCorrect, 114-115
comparison operators, 370
formulas, listing of, 369-370
functions, 372
legacy fields, 650-651
operators, 369
order of operations, 373
referencing values outside 

the table, 374
SmartArt diagrams 

creating equations, 
539-540

formatting, 542-543
inline versus display 

mode, 543
new blank equations, 539
preset equations, 539
professional versus linear 

layout, 541-542
saving equations to 

Equation Gallery, 544
structures, adding and 

filling, 540-541
text wrapping, 543

matrix diagrams, 518

MAX() function, 372

Merge Cells button, 346

merge fields 
address blocks, 565-567
greeting lines, 567-568
individual fields, 564-565
labels, 568-569

Merge to E-Mail dialog box, 
578

Merge to New Document 
dialog box, 577

Merge to Printer dialog box, 
577

{MergeField} field code, 631

{MergeRec} field code, 584, 631

{MergeSeq} field code, 584, 631

.mht extension, 35

.mhtml extension, 35

Microsoft
Fax, installing, 142
Forms 2.0 .NET 

Programmability Support, 
899

Graph, 899 
Office Communications 

Server 2007 R2 , 790 
Office Live Workspace, 777

signing up, 778-779
workspaces. See work-

spaces
Office Trusted Location 

dialog box, 804
Office Web Apps, 789
Query, 899
website, 894 
Word Mobile 2010 , 790 
Works file conversions , 890 

MIN() function, 372

Mini Toolbars, 9-10, 147

Mini-Translator, 123-124

MLA Sixth Edition, 696

modal dialog boxes, 12

Modify Building Block dialog 
box, 93

Modify Location dialog box, 48

Modify Style dialog box 
definitions, 239
names, 240
outlines, 668
table styles, 355
templates, 241

MOD(x,y) function, 372

mouse, 60, 63

moving
average trendlines, 501
clip art 

between collections, 462
 shapes,  472

documents, 24
folders, 24
footnotes/endnotes, 712
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modified clip art, 473-474
rows (tables), 345-346
subdocuments, 689
task panes, 12
text

cutting/copying/pasting,
65

dragging-and-dropping,
64

text boxes, 310

MS-DOS names, 45

multicolumn layouts, 280
breaks, 282
different settings for 

selected text, 283
newspaper-style, 280
presets, 281-282
settings, customizing,

282-283
tabular, 280
web pages, 824-826

multilevel lists 
creating, 674-676
custom, adding to Gallery, 

677
deleting, 680
double-numbering, 677
editing, 673
links, 675
list styles, 677-679
numbering options, 676
positioning, 674-675

multiple documents 
switching between, 16
viewing, 16-17

multiple headers and footers, 
275-276

multiple styles, 218

 N  
names

chart templates, 481
macros, 837, 848
MS-DOS, 45
Ribbon tabs, 870-871
styles, 229-230, 240
subdocuments, 690

navigating
Help, 17-18
insertion points, moving, 

59-60
keyboard shortcuts, 60-61
scrolling, 59
tables, 340

Navigation pane 
document maps, 82-83
highlighting found text, 75
text, finding, 72-74
viewing/hiding, 15

nesting
field codes, 621-622
subdocuments, 691-692
tables, 348

network share permissions, 
deleting, 795-796

New Address List dialog box, 
561

New Blog Account dialog box, 
829

New Collection dialog box, 460

New Column section breaks, 
254

New command (File menu), 
9, 20

New dialog box, 301

new documents 
creating

blank, 20-21
existing documents, 297
Office Online templates, 

293-295
sample templates, 292
template based, 22-23
user templates, 295-296

default settings, 19
hyperlinks, 591
startup, 19

new features, 5

newspaper-style multicolumn 
layouts, 280

{Next} field code, 631

Next Page section breaks, 254

{NextIf} field code, 631

{NextRecord} field code, 584

{NextRecordIf} field code, 584

nonbreaking hyphen caret 
code, 78

nonbreaking space caret code, 
78

nonprinting characters, 
viewing, 182

nonsupported file types, 
opening, 41

Normal.dotm template, 20, 289
fonts, 146
troubleshooting, 306-307

application data is miss-
ing, 307

missing, 306
original version, finding, 

307

not equal to operator (<>), 370

{NoteRef} field code, 628

NOT(x) function, 372

numbered lists 
bulleted lists, compared, 197
creating

AutoFormat As You Type, 
198-199

Numbering button, 198
formatting, 200-203

alignment, 201
custom, creating, 201-203
fonts, 200
number styles, 200
Numbering Library,

201-202
symbols, 201

indents, 208
levels, editing, 206-208
restarting/continuing,

199-200
starting at specific numbers, 

200

numbering
chart axes, 497-498
field codes, 625-626, 634-635
footnotes/endnotes, 714
formats, 370
lines, 262-263
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mail merge records, 584
outlines

applying, 671
multilevel lists, 672-673
troubleshooting, 671

pages on headers/footers 
adding, 269-270
formatting, 270-271

Numbering button, 198

Numbering Library, 201-202

 O  
objects

alignment, 433
distributing, 433-434
embedding, 603
flipping, 427
formatting

3-D effects, 445-446
3-D effects/shadows 

combination, 446
borders, 435-436
gradient fills, 439-441
pattern fills, 443-444
picture fills, 438-439
Quick Styles, 434
shadows, 444-445
solid fills, 435-438
texture fills, 442

layering with text, 431-432
positioning, 429
rotating, 427
selecting, 63
sizing, 427-428
SmartArt diagrams 

conversions, 538
text-wrapping, 429

ODBC (Open Database 
Connectivity) data sources, 
560-561

Odd Page section breaks, 254

.odt extension, 35

Office 2010 
deleting, 897 
installing, 895 -897

editing, 897 
file locations , 896 -897

installation options , 896 
user information , 897 

optional tools , 898 -899
Actions .NET 

Programmability
Support, 899

Actions Plugins , 899 
Clip Organizer, 899
Equation Editor , 899 
Hosted Webs , 899 
Language Settings Tool ,

899
Microsoft Forms 2.0 

.NET Programmability 
Support, 899 

Microsoft Graph , 899 
Microsoft Query , 899 
Optical Character 

Recognition, 899 
Picture Manager , 899 
SharePoint Foundation 

Support, 899 
Word , 899 

shared features , 899 

Office Clipboard 
clearing, 70
cutting/copying/pasting

text, 70
deleting items, 70
options, 70
task pane, 70
Windows Clipboard, 

compared, 64

Office.com
clip art collection, searching, 

457-458
templates

accessing, 22-23
downloading, 294
new documents, creating, 

293-295
searching, 294
viewing, 293

offline collaboration, 757

online collaboration, 757

Open and Repair mode, 42

Open as Copy mode, 41

Open command (File menu), 9

Open Database Connectivity 
(ODBC) data sources, 560-561

Open dialog box 
documents, opening, 38-39
file listing views, 39-40
file types, 40-41
multiple files, selecting, 39

Open in Browser mode, 42

Open in Protected View mode, 
42

Open Read-Only mode, 41

Open with Transform mode, 42

opening
AutoSaved files, 882
dialog boxes 

button drop-down lists, 
12

Ribbon buttons, 10
documents, 37

file types, 40-41
nonsupported file types, 

41
Open dialog box, 38-39
recently used, 37-38
special modes, 41-42

File menu, 8
help, 17
.lex files in Notepad, 108
macros in templates, 846
Mini Toolbars, 147
new documents, 19
Options dialog box, 883
print queues, 139
task panes, 12
templates, 297
Zoom dialog box, 16

OpenType fonts, 153-154, 170

Optical Character Recognition ,
899

option buttons (forms), 651

optional hyphen caret code, 78

Options command (File menu), 
9, 883

Options dialog box , 883 

Oracle database data sources, 
559-560
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order of operations (math), 373

Organizer dialog box, 245-246

orientation
envelope printing, 325
pages, 259

Orientation button, 259

orphans, 214

OR(x,y) function, 372

Outline view, 14

outlines, 661
copying, 680
creating

existing documents,
664-665

Outline view, 662
expanding/collapsing, 666
levels

paragraphs, 669
styles, 668-670
theme fonts, 669

lines, demoting/promoting, 
663-664

list styles, deleting, 680
master documents, 680-681

captions, 683
crashing Word, 682
headers and footers, 

681-683
numbered notes, 683
paginating, 694
printing, 694
separating into subdocu-

ments, 685-686
styles, 681
subdocuments, adding, 

684-685
TOCs/indexes, 683

multilevel lists 
creating, 674-676
custom, adding to 

Gallery, 677
deleting, 680
double-numbering, 677
editing, 673
fonts, 674
links, 675
list styles, 677-679
numbering options, 676

positioning, 674-675
numbering

applying, 671
multilevel lists, 672-673
troubleshooting, 671

printing, 680
rearranging, 667-668
styles, checking, 664-665
subdocuments

deleting, 689
editing, 688
locking/unlocking, 692
merging, 690-691
moving, 689
nesting, 691-692
renaming, 690
splitting, 692
unlinking, 689-690
viewing/collapsing, 687

viewing options, 667

outlining
text, 164-166
WordArt, 450

Outlook contact lists as data 
sources, 556-557

Overtype mode, 53

 P  
Page Background group (Page 

Layout tab), 6

page breaks 
creating, 263-264
soft, 263

page display options, 874-875

Page Down key, 61

{Page} field code, 626

page layout 
backgrounds, 283

fill effects, 283-284
printing, 284-285
selecting, 284

banners
birthday example, 321
creating, 321-322
page orientation, 321
spacing, 321

book folds, 258-259

borders, 285
creating, 285-286
paragraph borders, 

compared, 286
pictures/clip art, 286

cover pages, 264
creating, 264
deleting, 265
saving content as,

265-266
viewing, 265

envelopes
address positions, 

customizing, 324
creating, 322
E-Postage, 326-327
fonts, 324
graphics, 326
printer feed orientation, 

325
printing, 324
retrieving addresses, 326
sizes, 323-324
storing addresses, 326

folded note cards, 331
greeting card templates, 

332
paper selection, 332-333
quarter-fold note cards, 

331
upside-down text, 

creating, 333-334
frames

field codes, 319
formatting, 320
text box comparison, 320
text box conversions, 319

gutters, 258-259
headers and footers. See

headers and footers 
labels

formatting, 329-331
full page of same, 

printing, 327-328
single labels, 329
specifications,

customizing, 329-330
special paper, 327

line numbering, 262-263
margins. See margins 
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multicolumn, 280
column breaks, 282
different settings for 

selected text, 283
newspaper-style, 280
presets, 281-282
settings, customizing, 

282-283
tabular, 280

orientation, 259
page breaks 

creating, 263-264
soft, 263

paper size, selecting,
260-261

text boxes, 308
adding, 308-309
borders, 311
breaking, 316
converting to frames, 319
direction, changing, 317
drawing, 309
field codes, 319
fills, 312
formatting, copying, 311
frames comparison, 320
linking, 315-316
margins, 313-314
moving, 310
placement, 316-319
presets, 308-309
resizing, 310-311
selecting, 309
shapes, 312-313
vertical alignment,

313-314
wrapping text around, 

314-315
vertical alignment, 261-262
watermarks

built-in, adding, 278
customizing, 278-279
defined, 277
pictures, 279

Page Layout tab 
Line Numbers button, 262
Margins button, 256
Orientation button, 259
Page Background group, 6

paragraphs
indenting, 187
spacing, 186

Page Number Format dialog 
box, 270

Page Setup dialog box 
margins, 257
paper sizes, 260-261
section breaks, 255

Page Up key, 61

{PageRef} field code, 628

paper
labels, 327
size, selecting, 132-133,

260-261

Paragraph dialog box 
alignment, 197
breaks, 214-216
indentation, 187-188
line spacing 

before/after, 186
values, 184-185

paragraphs, 181
alignment, 196

justified, 197
left, 197
selecting, 197
types, 197

borders, 209
applying, 210
continuing,

troubleshooting, 209
deleting, 212
formatting, 211-212
page borders, compared, 

286
spacing, 212

breaks, 214
caret code, 78
customizing, 214-216
line breaks, compared, 52
widows versus orphans, 

214
character caret code, 78
combining, 183
excluding from hyphenation, 

87
formatting

end-of-paragraph
markers, 183

inheriting from preceding 
paragraphs, 182

indenting, 187
increments, 187
Indent buttons, 188-189
keyboard shortcuts,

188-189
Page Layout tab, 187
Paragraph dialog box, 

187-188
ruler, 189-190

line spacing, 183
before/after, 185-186
multipliers, selecting, 

183-184
precise values, 184-185

selecting, 63, 62
shading, 213-214
style, 217, 234
tab stops, 191

adding/removing on ruler, 
192-193

adding/removing with 
Tabs dialog box, 
193-194

converting tabbed lists to 
tables, 195-196

copying between 
paragraphs, 196

default intervals, 195
entire document, 

configuring,
lists, 191
tables, 191-192
types, 192-193
viewing on ruler, 194

parental controls, 127-128

password-protecting docu-
ments, 792-793

Paste Special command, 69

Paste Special dialog box, 69

pasting
tables from other Office 

applications, 376-377
text, 65

formatting options, 65-68
Office Clipboard, 70
Paste button menu 

options, 65-66
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Paste Options floating 
icon, 67

special, selecting, 69-70
Word Options dialog box, 

67-68

pattern fills, 284, 443-444

pausing print queues, 139

PDF documents, 154

.pdf extension, 35

personalization options,
875-877

Picture Bullet Dialog box, 206

Picture control, 643

picture diagrams, 520

picture fills (drawn objects), 
438-439

Picture Manager , 899 

pictures
accepted formats, 385-386
adding with {IncludePicture}. 

See {IncludePicture} field 
artistic effects, 400-401
backgrounds, deleting, 399
bevels, 406-407
bitmap images, 379
blogs, adding, 829-830
borders, 410-411
brightness/contrast, 397
bulleted lists, 206-207
captions, 412-413

adding, 412-413
automatic, 413

charge-coupled device 
(CCD), 379

Clip Organizer, adding, 461
color depth, 381-382
color models, 380-381
color modes, 398-399
compressing, 395-396

backward-compatible
documents, 396

Word 2010 documents, 
395-396

cropping, 393-394
digital, 379
effects

3-D, 406-407

3-D rotation, 409-410
glow, 406
reflections, 405
shadows, 403-405
soft edges, 406

envelopes, 326
file formats, 382
fills, 284
headers and footers, 275
hyperlinks, 589-590, 822-823
image resolution, 382-383
inserting from documents, 

384-386
page borders, 286
positioning, 388-391

anchors, 388-390
customizing, 391
manually, 388
presets, 390

presets, 402-403
resizing, 392-393
rotating, 407-408

manually, 407-408
specified amounts, 408

sharpening/softening,
397-398

sizes, 380
SmartArt, applying, 410-412
styles, applying, 401
text wrap, 386-388
web pages 

PNG, 818
VML, 818

Word compatibility, 383-384

pie charts, 486

pixels per inch (ppi), 395

Placeholder Name dialog box, 
703

placement
reference marks, 709
text boxes, 316-319

Plain Text control, 643

planning macros, 835-836

PNG graphics, 818

polygons, drawing, 420

polynomial trendlines, 501

positioning. See also
alignment

chart legends, 490-491
charts, 485-486
clip art, 465
endnotes/footnotes, 713-714
headers and footers, 274
multilevel lists, 674-675
objects, 429
pictures, 388-391

anchors, 388-390
customizing, 391
manually, 388
presets, 390

Quick Access toolbar, 864
SmartArt diagrams, 537
text, 169

posts (blogs), 829

power trendlines, 501

ppi (pixels per inch), 395

presets
charts

axes, 495
legends, 490
positions, 485

margins, 256-257
multicolumn layouts, 281-282
pictures

applying, 402-403
position, 390

text boxes, 308-309
TOCs, 724-726

previewing
mail merges, 576
web pages, 814-815

Print button (Help window), 18

Print command (File menu), 
9, 128

{Print} field code, 630

Print Layout view, 13 -14

{PrintDate} field code, 623

Printed Watermark dialog box 
customized watermarks, 278
picture watermarks, 279

printers
properties, configuring,

136-138
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queues, 139
errors, 139
jobs, 139-140
opening, 139
pausing, 139

resident fonts, 154
selecting, 128-129

printing, 128
background colors/images, 

135
blank pages, 140
both sides of paper, 131-132
collation, 130
content, scaling, 136
copies, selecting, 129-130
default settings, 128
document properties, 135
draft quality, 135
drawings, 135
envelopes, 324
field codes, 136, 633
fields, updating, 135
folded note cards 

paper selection, 332-333
quarter-fold note cards, 

331
upside-down text, 

creating, 333-334
fonts, 152
forms

data, 136
data only, 659
tips, 659-660

hidden text, 135
information sheets, 130
iron-on transfers, 138-139
labels, 554

full page of same, 327-328
single labels, 329
special paper, 327
specifications,

customizing, 329-330
letter mail merges, 551
linked data, updating, 135
margins, 133
master documents, 694
multiple drivers, 

configuring, 138
multiple pages per sheet, 

133

orientation, 132
outlines, 680
pages

backgrounds, 284-285
order, reversing, 136
orientation,

troubleshooting, 259
selecting, 130

paper size, 132-133
PostScript over text, 136
Print Preview, 133-134
print queues, 139

canceling jobs, 140
deleting all jobs, 139
errors, 139
opening, 139
pausing, 139

printers, selecting, 128-129
properties, 128
trays, selecting, 136
troubleshooting, 139
Word options, 135-136
XML tags, 136

privacy protection, 807
inspecting documents for 

personal information,
807-808

options, 809

process diagrams, 517

PRODUCT() function, 372

Proofing Errors icon, 100

Proofing group (Review tab), 7

properties, 43-44
Advanced, 44
building blocks, 93
custom

defining, 46-47
editing, 46
updating automatically, 

47
documents, printing, 135
fields, 616-619
legacy fields, viewing, 649
printers, configuring,

136-138
printing, 128
Standard, 44

listing of, 44
viewing, 44

web pages, 820-821

Properties, Advanced 
Properties command 
(File menu), 44

Properties dialog box 
tabs

Contents, 45
Custom, 45,
General, 45
Statistics, 45
Summary, 45

template types, 290-291

Protected View, 805-806

protecting
documents. See security 
forms, 655-657
macro viruses, 802

macro settings, 804-805
nonmacro file formats, 

selecting, 802
trusted locations, 802-804
trusted publishers, 804

privacy, 807
inspecting documents for 

personal information, 
807-808

options, 809
templates, 301

pyramid diagrams, 520

 Q  
quarter-fold note cards, 331

Quick Access toolbar, 6
AutoFormat, adding, 178
buttons, adding, 864-865
commands, adding, 6, 864
customizing, 6
new document button, 

adding, 21
repositioning, 864

Quick Styles, 220
adding/deleting, 222
drawn objects, 434
Gallery, 220
sets, 221-222

{Quote} field code, 628
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 R  
radar charts, 486

readability
calculating, 84
defined, 84
evaluating

Flesch Reading Ease, 84
Flesch-Kincaid Grade 

Level, 84
statistics, viewing, 84-85

read-only documents 
comments, allowing, 799
creating, 42-43, 796-797
editing restrictions, 797-798
form fields, filling in, 799
per-user exceptions, 800-801
recommending, 796
revision marks, forcing on, 

799
style restrictions, 799-800

rearranging outlines, 667-668

Recent command (File menu), 
9

recent documents, opening, 
37-38

Recent Documents list, 
customizing, 37

Recognized Math Functions 
dialog box, 115

Record Macro button, 836

Record Macro dialog box, 836

recording macros, 836
steps, 841-842
stopping, 843

records (mail merge) 
address validation, 575
advancing to next, 584
duplicate, finding, 574-575
error checking, 576
excluding, 570
filtering, 571-573
numbering, 584
searching, 574
sorting, 573-574

recovering documents , 881 
AutoRecover options, 

883-884

Document Recovery task 
pane, 881-882

unreadable files , 884 

red underlines (spell check-
ing), 95

Red/Green/Blue (RGB), 161,
380-381

redoing text, 54

{Ref} field code, 628

reference field codes, 628-627

reflections
charts, 511
pictures, 405
text, 166

Refresh button (Help window), 
18

registered trademark symbol 
(®), 54

registering blogs, 828-829

rejecting
automatic corrections, 

110-111
revisions, 767-768

relationship diagrams, 518

repairing Office 2010 
installation, 897

repeating text, 54

replacing text, 76

Research pane, 117
research providers, custom-

izing, 126
research services, enabling/

disabling, 126-127
translating languages, 123

research tools, 117
customizing

research providers,
125-126

research services, 
enabling/disabling,
126-127

Encarta Dictionary, 118-119
Research pane, 117
research services, 127-128
research sites, 120-121
thesaurus, 119-120

translation, 122
entire documents, 123
languages, selecting, 122
Mini-Translator, 123-124
options, configuring, 

124-125
Research pane, 123
WorldLingo website, 122

updating, 127

resolution (digital images), 
382-383

Restrict Formatting and 
Editing task pane, 656

return address labels, printing, 
327-328

Reveal Formatting task pane, 
146, 174-175

revealing text formatting,
174-175

Review tab 
Proofing group, 7
Reviewing Pane button, 758

reviewing documents. See
collaboration

Reviewing pane 
button, 758
viewing/hiding, 758-759

revisions
accepting/rejecting, 767-768
balloons, 758-761
character-level versus 

word-level, 773
colors/markings, 761
Full Screen Reading view, 

773-774
moving between screens, 

774-775
options, 776-777
tools, 775-776

locking, 768
moving between, 767
read-only documents, 799
reviewing, 765-766
tracking, 764

balloons, enabling/
disabling, 765

turning on/off, 764
usernames, 761-762
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{RevNum} field code, 626

RGB (Red/Green/Blue),
161, 380-381

Ribbon
buttons, dialog boxes, 

opening, 10
commands

adding, 869-870
deleting, 870

contextual tabs, 6
custom groups 

creating, 868
deleting, 869

customizing, 866
minimizing, 866
Quick Access toolbar, 6
resetting to original, 871
tabs, 6

contents, viewing, 6-7
creating, 868
deleting, 869
dialog box associations, 

12
groups, collapsing, 7
Page Layout, 6
renaming/reordering,

870-871
Review, 7
View, 14
viewing/hiding, 866-867

Rich Text control, 643

right paragraph indentation, 
187

right tab stops, 192

Rotate button, 408

rotating
clip art, 471
drawn objects, 427
pictures, 407-408

manually, 407-408
specified amounts, 408

ROUND(x.y) function, 372

rows (tables) 
adding, 343-344
deleting, 345
moving/copying, 345-346
selecting, 63, 342

.rtf extension, 35

ruler
indenting paragraphs,

189-190
tab stops 

adding/removing, 192 -193
viewing, 194

viewing/hiding, 15

running macros, 843-842

 S  
sample templates, 292

new documents, creating, 
292

storage locations, 297

Save & Send command 
(File menu),

Save As command (File menu), 
8

Save As dialog box, 24
file management, 24
save locations, editing, 24

Save Chart Template dialog 
box, 480

Save command (File menu), 8

Save Current Theme dialog 
box, 248

{SaveDate} field code, 623

saving
AutoSaved files, 882
bibliographies, 707-708
content as cover pages,

265-266
custom TOC presets, 732
documents, 24, 47-49

autorecover intervals, 
customizing, 48-49

default format, 48,
892-893

default save locations, 
setting, 47-49

favorite locations, 30-31
file formats, 31-36
FTP sites, 29-30
locations, 877-878
network locations, 27-28
as read-only, 42-43

save locations in 
Windows Vista or 
Windows 7, 24

save locations in 
Windows XP, 26

web format, 34-36
web locations, 29

forms
data only, 658-659
as templates, 639-640

templates, 294-295
text to Clipboard, 66
web pages, 815-816

browser compatibility, 
816-817

fonts, 820
language encoding, 820
options, 818-819
properties, 820-821
sizes, 819

scale
chart axes, 495-498
text, 169

scribbles, customizing, 425-426

scroll bar, 59

scroll box, 59

scrolling, 59

searching. See also finding 
and replacing 

clip art, 452
Clip Organizer, 459
Office Online collection, 

searching, 457-458
document maps, 82-83
field codes, 633
Go To tab, 81-82
Help, 18-19
mail merge records, 574
Office Online templates, 294
Select Browse Object 

feature, 80
spelling errors, 100

{Section} field code, 626

{SectionPages} field code, 626

sections
character caret code, 78
creating, 253
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defined, 253
section breaks 

caret code, 78
creating, 255
deleting, 255
types, customizing, 255
types, listing of, 254

vertical alignment, 
configuring, 261-262

security, 791-792
access restrictions 

decrypting folders, 795
encryption, 793-794
network share permis-

sions, deleting, 795-796
password-protecting,

792-793
permissions, 794

digital signatures, 809-810
adding, 810
invalid, troubleshooting, 

810
reviewing, 810
third-party certificates, 

492
file blocking, 806-807
forms, 655-657
macro virus protection, 802

macro settings, 804-805
nonmacro file formats, 

selecting, 802
trusted locations, 802-804
trusted publishers, 804

macros, 857
settings, customizing, 

858-859
trusted publishers/

locations, 857-858
privacy protection, 807

inspecting documents for 
personal information, 
807-808

options, 809
Protected View, 805-806
read-only documents 

comments, allowing, 799
creating, 796-797
editing restrictions, 

797-798
form fields, filling in, 799

per-user exceptions, 
800-801

recommending, 796
revision marks, forcing 

on, 799
style restrictions, 799-800

templates, protecting, 301

Select Browse Object feature, 
80

Select Data Source dialog box, 
483, 558

Select Table dialog box, 558

selecting
backgrounds, 284
clip art shapes, 472
custom dictionaries, 107
fonts, 147-148
found text, 74
graphics, 63
languages, 105
mail merges, 552-553
margin presets, 256-257
objects, 63
paper sizes, 260-261
paste formats, 69-70
printers, 128-129
tables, 343

cells, 340-342
columns, 342-343
rows, 342

text
entire document, 62-63
extending selections, 

disabling, 60
F8 key, 64
keyboard shortcuts, 62
lines, 62-63
mouse, 60
multiple noncontiguous 

selections, 63
paragraphs, 62-63
rectangular blocks, 62-63
sentences, 63
tables, 63
text boxes, 63
words, 62-63

text boxes, 309
translation languages, 122

sending email from Word, 831

sentences, selecting, 63

separator lines (footnotes/
endnotes), 715-717

{Seq} field code, 626

{Set} field code, 583-584, 631

shading paragraphs, 213-214

Shading button, 213

shadows
3-D effects combination, 446
charts, 509-511
clip art, 470
drawn objects, 444-445
paragraph borders, 211
pictures, 403-405

backward-compatible
documents, 405

Word 2010 documents, 
403-404

text, 166

shapes
3-D effects, 445-446
borders, formatting, 435-436
charts, 509-510

series, 513
styles, 508-509

clip art images, 417
customizing, 426
drawing, 417-418, 420
fills

gradient, 439-441
pattern, 443-444
pictures, 438-439
solid, 435-438
texture, 442

flipping, 427
grouping, 432-433
layering, 431-432
lines, anchoring, 429-431
positioning, 429
rotating, 427
shadows, 444-445
sizing, 427-428
SmartArt diagrams 

adding, 522-523
deleting, 523
enlarging, 535
fills/outlines/effects, 534
geometry, customizing, 

534-535
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moving, 535
promoting/demoting,

523-524
rotating/flipping, 536
Shape Styles, applying, 

534
shrinking, 536
sizing, 535

text
adding, 422-423
wrapping, 429

text boxes, 312-313
WordArt, 448-449

Shapes button, 417

shared features (Office 2010) ,
899

SharePoint
Foundation Support, 899
Workspace 2010, 788-789

sharing
documents, 891 -892
workspaces, 781-782

sharing data. See data sharing 

sharpening pictures, 397-398

Shift+↑, 63

Shift+↓, 63

Shift+arrow keys keyboard 
shortcut, 63

Shift+End keyboard shortcut, 
63

Shift+Enter keyboard shortcut, 
51

Shift+F6 keyboard shortcut, 61

Shift+F9 keyboard shortcut, 
631

Shift+F11 keyboard shortcut, 
631

Shift+Home keyboard shortcut, 
63

Shift+Tab keyboard shortcut, 
61, 340

Show group (View tab), 15

Show Previous Versions mode, 
42

Show Table of Contents button 
(Help window), 18

Show/Hide button, 182

Sign dialog box, 810

Signatures pane, 810

SIGN(x) function, 372

single opening/closing quote 
(‘), 54

Single-File Web Page file 
format, 36

SIST02 citation style, 697

sizes
clip art, 465
digital pictures, 380
drawing canvas, 421-422
envelopes, 323-324
fonts, 149-151
modified clip art, 473-474
objects, 427-428
paper, selecting, 260-261
pictures

bullets, 206
resizing, 392-393

SmartArt diagrams, 536-537
tables

AutoFit settings, 349-350
default, 349
even column widths, 353
precise values, 350-352
resizing by dragging, 350
resizing entire table,

353-354
text boxes, 310-311
vector graphics, 416
web pages, 819

{SkipIf} field code, 631

{SkipRecordIf} field code, 584

SkyDrive, 784
configuring, 784-786
document options, 786
uploading documents,

786-788

small caps effect, 165

smart paragraph selection, 
disabling, 60

Smart Tags. See actions 

SmartArt diagrams 
adding, 521
bulleted lists, adding, 524
categories, 517-521
colors, 533
converting to regular 

drawing objects, 538
cycle, 518
defined, 517
flow direction, 522
hierarchy, 517
layout, customizing, 522
list, 517
math equations 

creating, 539-540
formatting, 542-543
inline versus display 

mode, 543
new blank equations, 539
preset, 539
professional versus linear 

layout, 541-542
saving to Equation 

Gallery, 544
structures, adding and 

filling, 540-541
text wrapping, 543

matrix, 518
organization chart branches, 

524-525
pictures, applying, 410-412,

520
positioning, 537
process, 517
pyramid, 520
relationship, 518
resizing, 536-537
shapes

adding, 522-523
deleting, 523
enlarging, 535
fills/outlines/effects, 534
geometry, customizing, 

534-535
moving, 535
promoting/demoting,

523-524
rotating/flipping, 536
Shape Styles, applying, 

534
shrinking, 536
sizing, 535
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SmartArt Styles, applying, 
530-531

spell checking, 521
text

adding, 525
editing, 525
fonts, 526
formatting controls,

526-528
positioning within 

shapes, 529-530
text pane, 528-529
WordArt Styles, 528

themes, 532

SmartArt Graphic dialog box, 
521

soft edges 
charts, 512
pictures, 406

soft page breaks, 263

softening pictures, 397-398

solid fills (drawn objects),
435-438

sorting
delimited data 

not in tables, 368
tables, 367-369

merge records, 573-574

Source Manager dialog box, 
698

sources
creating for citations, 702
deleting, 700
editing, 699-700
entering, 698-699
inline references, 701-702
temporary placeholders, 

702-703
transferring to/from Master 

List, 701

spacing
{AddressBlock} field, 549
banners, 321
charts, 514
lists, 208
paragraph borders, 212
text, 168, 169

editing, 168

kerning, 169-170
OpenType fonts, 170
positioning, 169
scale, 169

special characters, finding and 
replacing, 78-79

caret codes (^), 78
text string codes, 79

special paragraph indentation, 
187

spell checking 
customizing, 100

exceptions, 102
Office spelling options, 

101-102
Word only options, 102

dictionaries, 104
adding to Word, 108-109
creating, 106-107
default, 104, 107
enabling/disabling, 107
exclusion, 107-108
flagged words, adding, 

104
languages, selecting, 105
multiple words, adding, 

105-106
word list, editing, 104-105

indexes, 749
individual words, 95-96

options, 96
red/blue lines, 95

interactive spelling and 
grammar check, 98-100

languages
multiple, 109-110
selecting, 96-97

Proofing Errors icon, 100
SmartArt diagrams, 521

Spelling & Grammar dialog 
box, 98

exceptions, 102
Office spelling options, 

101-102
Word only options, 102

Split Cells button, 347

splitting
subdocuments, 692

tables
cells, 347-348
entire tables, 348

SQL database data sources, 
559-560

Stamps.com, 326

Standard properties, 44
listing of, 44
viewing, 44

Start Enforcing Protection dia-
log box, 656, 798

Statistics tab (Properties 
dialog box), 45

status bar 
customizing, 873-874
views, switching, 14

Status field, 44

stock charts, 486

Stop button (Help window), 17

storing templates, 297-298

straight lines, drawing,
419-420

strikethrough effect, 165

Style area, viewing, 228-229

Style dialog box, 752

Style Inspector, 226-227

Style Pane Options dialog box, 
225, 245

{StyleRef} field code, 628

styles, 217
Apply Styles pane, 224
applying, 218, 219
automatic updates, 232
cascading style definitions, 

241
Cascading Style Sheets 

(CSS), 812, 827
character, 161, 218
charts, 506
citation, 696
clearing, 226
copying between 

documents, 245-246
creating, 219
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creating by definition, 
233-237

availability, 237
Create New Style from 

Formatting dialog box 
options, 233-234

paragraph/linked styles, 
234

Quick Styles gallery, 
adding, 236

table styles, 234-235
updates, 237

creating by example,
231-232
Quick Style Gallery list, 

231
Styles pane, 231-232

default, redefining, 239-240
definitions, editing, 239
deleting, 238
editing, 219, 241-242
endnotes/footnotes, 714-716
fonts, 161

applying, 162-163
character styles, com-

pared, 161
deleting, 162
true versus false, 161-162

heading, 220
indexes, 752-753
keyboard shortcuts 

assigning, 237
built-in, 237

linked, 218
creating, 234
disabling, 225

lists, 218
filtering, 244-245
sort order, editing,

243-244
master documents, 681
names, 229-230
order of application, 677
outlines, checking, 664-665
paragraph, 217, 234
pictures, applying, 401
Quick Styles, 220

adding/deleting, 222
Gallery, 220
sets, editing, 221-222

read-only document 
restrictions, 799-800

renaming, 240
Style area, viewing, 228-229
Style Inspector, 226-227
Styles pane, 222-224

availability, 226
built-in style names, 226
creating styles by 

example, 231-232
customizing, 225-226
formatting, 226
linked styles, disabling, 

225
list options, 226
menu options, 222-224
Show Preview, 225
Style Pane Options dialog 

box, 225
styles, viewing, 225
viewing, 222

tables, 218
applying, 354
creating, 234-235, 355-357
customizing, 355-357
default, 355

template, editing, 241
TOCs, 730
updating

automatically, 238-239
matching selections, 239

Styles pane, 222-224
availability, 226
built-in style names, 226
creating styles by example, 

231-232
customizing, 225-226
formatting, 226
linked styles, disabling, 225
list options, 226
menu options, 222-224
Show Preview, 225
Style Pane Options dialog 

box, 225
styles, viewing, 225
viewing, 222

subdocuments
adding to master documents, 

684-685
creating, 685-686
deleting, 689
editing, 688

locking/unlocking, 692
merging, 690-691
moving, 689
nesting, 691-692
renaming, 690
splitting, 692
unlinking, 689-690
viewing/collapsing, 687

{Subject} field, 44

subscript effect, 165

SUM() function, 372

Summary tab (Properties 
dialog box), 45

superscript effect, 165

surface charts, 486

switching between 
Insert mode and Overtype 

mode, 53
open documents, 16
views, 14-15

Symbol dialog box, 56-57, 204

{Symbol} field code, 627

symbols
automating, 57-58

AutoCorrect entries, 
57-58

keyboard shortcuts, 57-58
bulleted lists, 204-205
character codes, 57
finding and replacing, 78-79

caret codes (^), 78
text string codes, 79

footnotes/endnotes, 714
inserting

keyboard shortcuts/
AutoCorrect shortcuts, 
54-55

Symbol dialog box, 56
numbered lists, 201

synchronous scrolling, 769

synonyms, looking up, 119-120

 T  
tab character caret code, 78

Tab key, 51, 61
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tab stops, 191
adding/removing

ruler, 192-193
Tabs dialog box, 193-194

converting tabbed lists to 
tables, 195-196

copying between para-
graphs, 196

default intervals, 195
entire document, configur-

ing, 191
lists, 191
tables, 191-192
types, 192-193
viewing on ruler, 194

tabbed lists, converting to 
tables, 195-196

Table button, 337

table of authorities, 
generating, 737-738

table of contents. See TOCs 

table of figures, 735
captioning figures, 735-736
generating, 736
manually marking captions, 

737

Table of Figures Options 
dialog box, 736

Table Options dialog box, 361

Table Positioning dialog box, 
365

Table Properties dialog box 
alignment, 364
cell margins, 362
headings, 363
sizing tables, 351-352
text wrapping, 365

tables, 335
adding

Insert Table dialog box, 
337-338

Table menu, 337
alignment, configuring, 364
captions, 366

adding, 366-367
formatting, 366-367

cells
adding, 343
backgrounds, 357
borders, 358-361
deleting, 345
margins, 361-362
merging, 346-347
selecting, 63, 340-342
splitting, 347-348
text alignment, 362
text direction, 363

columns
adding, 343-344
deleting, 345
selecting, 63, 342-343
sizing evenly, 353

converting
text to, 374-375
to text, 375-376

data entry, 339-340
deleting, 345
drawing, 338-339
Excel worksheets, 

embedding, 377-378
field codes, 627
headings, 363
math calculations, 369

comparison operators, 
370

formulas, 369-370
functions, 372
operators, 369
order of operations, 373
referencing values out-

side the table, 374
multicolumn web page 

layouts, 824-826
navigating, 340
nested, creating, 348
number formats, 370
pasting from other Office 

applications, 376-377
rows

adding, 343-344
deleting, 345
moving/copying, 345-346
selecting, 63, 342

selecting, 63, 343

sizes
AutoFit settings, 349-350
default, 349
even column widths, 353
precise values, 350-352
resizing by dragging, 350
resizing entire table,

353-354
sorting, 367-369
splitting/rejoining, 348
styles, 218

applying, 354
creating, 234-235, 355-357
customizing, 355-357
default, 355

tabbed lists, converting, 
195-196

text wrapping, 364-366

tabs (Ribbon), 6
contents, viewing, 6-7
contextual, 6
dialog box associations, 12
groups, collapsing, 7
Page Layout, 6
Review, 7

Tabs dialog box, 193-194

tabular multicolumn layout, 
280

task panes 
Apply Styles, 224
availability, 226
Clip Art, 452
closing, 12
moving, 12
Navigation

document maps, viewing, 
82-83

text, finding, 72
Office Clipboard, 70
opening, 12
Research, 117

research providers, 
customizing, 126

research services, 
enabling/disabling,
126-127

translating languages, 
123
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Restrict Formatting and 
Editing, 656

Reveal Formatting,
146, 174-175

Reviewing, 758-759
Signatures, 810
Style Pane Options dialog 

box, 225
Styles, 222-224

built-in style names, 226
creating styles by 

example, 231-232
customizing, 225-226
formatting, 226
linked styles, disabling, 

225
list options, 226
menu options, 222-224
Show Preview, 225
styles, viewing, 225
viewing, 222

text, 528-529

{TC} field code, 727-728

templates
add-ins, 887
application customization, 

289-290
applying different, 302-303
automatically changing for 

all open documents,
305-306

charts, 480
backing up, 481
creating, 480
deleting, 481
managing, 481
names, 481
new charts, starting, 481

checking type, 290-291
creating, 301
editing, 300
global

applying, 303-304
disabling, 304
enabling at startup, 304
loading at startup, 304

greeting card, 332
local, accessing, 23
macros, opening, 846
mail merges, 563

moving
New dialog box tab, 301
workgroup folder, 299

new documents based on 
Office Online templates, 

293-295
sample, 292
user templates, 295-296

new documents, creating, 
22-23

installed templates, 23
Office.com, 22-23

Normal.dotm, 20, 289
fonts, 146
troubleshooting, 306-307

Office Online 
accessing, 22-23
downloading, 294
searching, 294
viewing, 293

opening, 297
preventing from loading at 

startup, 304
protecting, 301
sample, 292
saving, 294-295, 639-640
storage locations, 297-298
styles, editing, 241
types, 290
web pages, 826
Word (.dotx), 290
Word 97-2003 (.dot), 290
Word Macro-enabled (.dotm), 

290
workgroups

accessing, 298-299
folders, creating, 298-299
storage locations, 297

text
adding with {IncludeText} 

field. See {IncludeText} 
field

AutoCorrect, 110
adding formatted entries, 

113-114
adding text entries, 113
editing entries, 113
exceptions, 112-113
math, 114-115
options, configuring,

111-113

rejecting corrections, 
110-111

AutoFormat, 176
adding to Quick Access 

toolbar, 178
applying, 179-180
AutoFormat As You Type 

options, 176-177
options, configuring, 

178-179
building blocks 

accessing, 89
Building Blocks.dotx 

corrupt file, 91
creating, 89-90
deleting, 92
inserting, 90-91
overview, 89
properties, editing, 93

case
Capitalize Each Word 

option, 166
Change Case feature, 167
changing, 167

cells (tables) 
alignment, 362
direction, 363

charts
formatting, 514-515
WordArt Styles, 515-516

citation conversions, 704
converting to tables, 374-375
cutting/copying/pasting, 65

formatting options, 65-68
Office Clipboard, 70
pasting formats, 

selecting, 69-70
deleting, 52
delimited data, 367
dragging-and-dropping, 64
drop caps, 170

creating, 172
deleting, 172
Dropped-style, 170-172
In-Margin, 170-172
options, 172-173

dummy text 
adding, 89
overview, 88
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effects, 164
3D, 166
all caps, 165
double strikethrough, 165
filling, 164
glowing, 166
hidden, 165-164
outlining, 164-166
reflections, 166
shadows, 166
small caps, 165
strikethrough, 165
subscript, 165
superscript, 165

entering, 51
Insert mode versus 

Overtype mode, 53
line breaks versus 

paragraph breaks, 52
field code conversions, 633
finding and replacing 

customizing, 75-62
Find and Replace dialog 

box, 73
highlighting all found, 75
Navigation pane, 72
replacing text, 76
selecting all found, 74
special characters, 78-79

fonts
adding, 154-156
assigning, 146
colors, 158-161
default, 146, 151-153
embedding, 157-158
Font dialog box, 150-151
Font list, 

troubleshooting, 148
formatting, 146
OpenType versus 

TrueType, 153-154
PDF documents, 154
printer-resident, 154
printing, 152
Reveal Formatting task 

pane, 146
selecting, 147-148
sizes, 149-151
styles. See fonts, styles 
substituting, 158
theme, 148

formatting
comparing, 175
copying, 173-174
deleting, 173
revealing, 174-175

fractions, 171
hidden, printing, 135
highlighting, 167-168
hyperlinks, creating, 587-589
leaders, 193
legacy fields, 649-650
objects, layering, 431-432
redoing, 54
repeating, 54
saving to Clipboard, 66
selecting

entire document, 62-63
extending selections, 

disabling, 60
F8 key, 64
graphics, 63
keyboard shortcuts, 62
lines, 62-63
mouse, 60
multiple noncontiguous 

selections, 63
paragraphs, 62-63
rectangular blocks, 62-63
sentences, 63
tables, 63
text boxes, 63
words, 62-63

shapes, adding, 422-423
SmartArt diagrams 

adding, 525
editing, 525
fonts, 526
formatting controls,

526-528
positioning within 

shapes, 529-530
text pane, 528-529
WordArt Styles, 528

spacing, 168, 169
editing, 168
kerning, 169-170
OpenType fonts, 170
positioning, 169
scale, 169

symbols, inserting 
automating, 57-58
keyboard shortcuts/

AutoCorrect shortcuts, 
54-55

Symbol dialog box, 56
tables

conversions, 375-376
wrapping, 364-366

text boxes 
direction, changing, 317
wrapping around,

314-315
underlining, 163-164
undoing, 53-54
upside-down, creating, 

333-334
WordArt, applying, 448
wrapping

charts, 485
clip art, 462-464
objects, 429
pictures, 386-388
SmartArt diagrams, 543
WordArt, 448

text boxes, 308
adding, 308-309
borders, 311
drawing, 309
field codes, 319
fills, 312
formatting, copying, 311
frames

compared, 320
converting to, 319

headers and footers, adding, 
276

linking
breaking, 316
creating, 315-316

margins, 313-314
moving, 310
placement, 316-319
presets, 308-309
resizing, 310-311
selecting, 63, 309
shapes, 312-313



text boxes940

text
direction, changing, 317
wrapping around, 

314-315
vertical alignment, 313-314

Text Direction button, 363

Text Effects dialog box 
3D, 166
filling, 164
glowing, 166
outlining, 164-166
reflections, 166
shadows, 166

texture fills, 442

themes, 246
applying, 247
colors, 246

applying, 248-249
creating, 248-250

creating, 248
default, configuring, 247-248
fonts, 148

applying, 250-251
colors, 159
creating, 250-251
editing, 151-153
troubleshooting, 251

SmartArt diagrams, 532

thesaurus, 119-120

thick typographical left arrow, 
54

thick typographical right 
arrow, 54

third-party certificates, 492

{Time} field code, 623

tints (fonts), 159

Title property, 44

{TOC} field code, 731-733

TOCs (table of contents) 
creating from presets,

724-726
custom

appearance, 731-732
basic options, 729
deleting presets, 732
elements to include, 

marking, 730

saving presets, 732
starting, 728-729

deleting, 726
marking entries, 727

entire paragraphs, 727
TC fields, 727-728

master documents, 683
multiple, 732

entire document, adding, 
734

multiple documents,
734-735

partial document, 
adding, 734

style outline levels, 
checking, 723-724

styles, 730
{TOC} field code, 731-733
updating, 726

toolbars
Document Properties, 44
macro assignments, 840-841,

850
Mini Toolbars, 9-10
Quick Access 

AutoFormat, adding, 178
buttons, adding, 864-865
commands, adding, 864
customizing, 6
new document button, 

adding, 21
repositioning, 864

tools. See also utilities 
Citations and Bibliography, 

696
collaboration, 757

Reviewing pane, 758-759
revision colors/markings, 

761
tracked changes balloons, 

758-761
usernames, 761-762

Crop, 393
Freeform, 420
Full Screen Reading view, 

775-776
legacy fields, 648
Office 2010 optional , 898 -899

Actions .NET 
Programmability
Support, 899 

Actions Plugins , 899 
Clip Organizer , 899 
Equation Editor, 899
Hosted Webs, 899
Language Settings Tool, 

899
Microsoft Forms 2.0 

.NET Programmability 
Support, 899 

Microsoft Graph , 899 
Microsoft Query , 899 
Optical Character 

Recognition, 899 
Picture Manager , 899 
SharePoint Foundation 

Support, 899 
Word, 899 

research, 117
Encarta Dictionary,

118-119
Research pane, 117
research providers, 

customizing, 125-126
research services, 

enabling/disabling,
126-127

research services, paren-
tal controls, 127-128

research sites, 120-121
thesaurus, 119-120
translation. See

translating languages 
updating, 127

Track Changes Options dialog 
box, 759

trademark symbol (™), 54

translating languages, 122
entire documents, 123
languages, selecting, 122
Mini-Translator, 123-124
options, configuring, 124-125
Research pane, 123
WorldLingo website, 122

trendlines (charts), 499-501
adding, 500
options, 501
types, 501
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troubleshooting
add-ins causing Word to 

crash, 861
AddressBlock field spacing, 

549
Building Blocks.dotx corrupt 

file, 91
crashes, 885 -887

add-ins/extensions,
disabling, 886 -887

document specific , 885 
error reports , 885 
updates, checking , 885 

cross-references, 720
field codes 

syntax errors, 619
updates, 631

Font list, 148
footnotes disappearing, 717
indexes

codes, viewing, 742
marked entries not 

showing, 745
page numbering, 749

invalid digital signatures, 
810

macros, 844-845
availability, 844
runtime errors, 845
viewing, 837

master documents, crashing 
Word, 682

nonsupported file types, 41
Normal.dotm template,

306-307
application data is 

missing, 307
missing, 306
original version, finding, 

307
Office Online template 

downloads, 294
outlines, numbering, 671
page backgrounds, printing, 

284-285
page orientation, printing, 

259
paragraph borders, 209
printing, 139

blank pages, 140
errors, 139

styles, automatic updates, 
232

themes, fonts, 251
unreadable files , 884 
WordArt, too much text, 448

TRUE function, 372

TrueType fonts, 153-154

Trust Center dialog box, 805

trusted locations, 802-804,
857-858

trusted publishers, 
804, 857-858

Turabian Sixth Edition citation 
style, 696

.txt extension, 35

typefaces. See fonts 

typographical left arrow (←), 54 

typographical right arrow (→),
54

 U  
underlining

hyperlinks, 592
text, 163-164

undoing text, 53-54

Unicode, 57

Uniform Resource Locators 
(URLs), 822

unlinking subdocuments,
689-690

unreadable documents, 
recovering, 884 

unsupported file formats, 
converting, 891 

updating
custom properties, 47
field codes, 613, 631

before printing, 135
locking against, 632
printing, 633
troubleshooting, 631

{IncludePicture} field, 612
{IncludeText} field, 611-612
indexes, 749

linked data before printing, 
135

research tools, 127
styles, 232, 237

automatically, 238-239
matching selections, 239

TOCs, 726
Word, 885

up/down bars (charts), 505

upside-down text, creating, 
333-334

URLs (Uniform Resource 
Locators), 822

{UserAddress} field code, 625

{UserInitials} field code, 625

{UserName} field code, 625

usernames, 761-762

users
information field codes, 625
interface

buttons, 10-12
dialog boxes, 10
File menu, 8
Mini Toolbars, 9-10
new features, 5
personalization options, 

875-877
Ribbon. See  Ribbon 

templates
moving to workgroup 

folder, 299
new documents, creating, 

295-296
storage locations, 297

utilities. See also tools 
Clip Organizer, 66
ClipBook Viewer, 66

 V  
value axis (charts), 475

VBScript, 812

vector graphics 
bitmaps, compared, 415-416
functions, 417
sizes, 416
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Vector Markup Language 
(VML), 812, 818

vertical alignment 
configuring, 261-262
text boxes, 313-314
WordArt, 451

View tab 
Show group, 15
views, switching, 14
Zoom button, 16
zooming in/out, 15-16

viewing
add-ins, 860
Advanced properties, 44
Apply Styles pane, 224
button galleries, 11
clip art information, 453-454
comments, 763-764
cover pages, 265
document maps, 82-83
documents side by side, 769
documents without Word, 

893-894
embedded files, 601
extensions, 31
field codes, 268, 621
gridlines, 15
headers and footers, 266-267
indexing codes, 742-743
legacy field properties, 649
macros, 837
Mini Toolbars, 9-10
multiple documents/win-

dows, 16-17
Navigation pane, 15
nonprinting characters, 182
Office Online templates, 293
Protected View, 805-806
readability statistics, 84-85
Reviewing pane, 758-759
Ribbon tabs, 6-7, 866-867
ruler, 15
Standard properties, 44
Style area, 228-229
Styles list sort order, 243-244
Styles pane, 222
subdocuments, 687
word counts, 85

views
Draft, 14
Full Screen Reading, 14
Open dialog box, 39-40
Outline, 14
Print Layout, 13 -14
switching, 14-15
Web Layout, 13 -14

VML (Vector Markup 
Language), 812, 818

 W  
walls (charts), 475

watermarks
built-in, adding, 278
customizing, 278-279
defined, 277
pictures, 279

Web Layout view, 14

Web Options dialog box, 816
Browsers tab, 816-817
Encoding tab, 820
Files tab, 818-819

Web Page file format,

Web Page, Filtered file format, 
34

web pages 
blogs, compared, 827
CSS, 827
designing, 811-812
disadvantages for Word, 814
documents, saving, 29
file formats, 812-813
fonts, 820
graphics

PNG, 818
VML, 818

hyperlinks, 821
email, 823-824
images, 822-823
text, creating, 822

language encoding, 820
multicolumn layouts, 824-826
options, 818-819
previewing, 814-815
properties, 820-821
saving, 815-817

sizes, 819
templates, 826
Word features lost in web 

format, 813

web-based file formats, 34-36

websites
Microsoft, 894 
Microsoft Office Live 

Workspace, 777
research, 120-121
SkyDrive, 784
Stamps.com, 326
WorldLingo, 122

white space caret code, 78

widows, 214

windows
Help, 17-18
multiple

arranging, 16
viewing, 16-17

switching between, 16

Windows Clipboard, 64

Word (.dotx) templates, 290

Word 97-2003 (.dot) templates, 
290

Word add-ins , 887 

Word Macro-enabled (.dotm), 
290

Word Options dialog box 
Cut, Copy, and Paste 

section, 67-68
fonts

embedding, 157-158
substituting, 158

printing, 135-136
spelling and grammar 

checker, 101

Word Viewer , 894 

WordArt, 446
alignment, 451
applying to regular text, 448
charts, 515-516
creating, 446
customizing, 447
fills, 450
formatting, 448
new features, 446
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outlining, 450
shapes, 448-449
SmartArt diagrams, 528
text wrapping, 448
too much text, 448
upside-down text, creating, 

333-334
vertical text direction, 450

word-level revisions, 773

WordML files, 31

WordPerfect file 
conversions, 890 -891

words
adding to spelling 

dictionary, 104-106
counting, 85
looking up in Encarta 

Dictionary, 118-119
looking up in thesaurus, 

119-120
selecting, 62-63
spell checking, 95-96

options, 96
red/blue lines, 95

workgroup templates 
accessing, 298-299
folders, creating, 298-299
storage locations, 297

workspaces
creating, 779-780
defined, 778
documents

adding, 781
editing, 782-783

managing, 783-784
sharing, 781-782

WorldLingo website, 122

.wps extension, 35

 X  
{XE} field codes, 746

XML (Extensible Markup 
Language), 31, 812

Expansion Packs , 887
Schemas, 887
tags, printing, 136

.xml extension, 35

.xps extension, 35

XY charts, 486

 Z  
Zoom button (View tab), 15-16

Zoom dialog box, 16

Zoom slider, 15

zooming in/out, 15-16
View tab, 15-16
Zoom slider, 15
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